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Trimble FieldLink

Trimble FieldLink software provides a single solution for your field layout and scanning tasks:

e Use arobotic total station or GNSS receiver to precisely layout directly from the model or created
lines.

e Quickly and effectively collect points, lines and curves to create your own 3D project as-built or
surface analysis.

e Quickly and easily collect as-built points with FieldLink and the Trimble Ri or Trimble RTS series
Robotic Total Stations. Ensure accuracy with your model in real time.

e Leave the jobsite with a registered point cloud aligned to your constructable model which you can
easily export to your preferred CAD program.

Work Modes

The FieldLink home screen opens with the Work Mode icons across the top of the screen.

The Work Modes are a logical division of work features within the software. Tap the required work mode
icon at any time to enter that work mode.
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Trimble FieldLink

Create

“~
Tap Create . to create, modify or delete project data including a plan view of a project, linework, points,
points from a model, grid points or point patterns.

Measure

Tap Measure n to:

Lay out points, lines, offsets, arcs

Collect points, lines, arcs or to auto collect square cateye control points
Lay out wall penetrations

Lay out planes

Collect and lay out surfaces

Change measurement settings such as tolerances, next or nearest points, Visual Layout or Standard
Laser mode, and High Precision or Fast Precision.
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Trimble FieldLink

Device

Tap Device | L8 (0 connect to GNSS, total station, or scanning equipment, set up the instrument location,
and change instrument and target settings.

If you have purchased GNSS equipment, you can connect to Trimble R8s GNSS receivers and VRS or RTX
networks depending on your license type.

If you have a Trimble Tablet with a built-in radio or optional external radio, you can connect to various
Trimble Robotic Total Stations and the Trimble X7 or X9 3D Laser Scanner.
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Trimble FieldLink

Map

Tap More ' and then tap Map to go to the map view of your model.

You can also move, scale, or rotate models and background files in FieldLink Office under Map.

Projects

Tap More ' and then tap Projects to open or create job files, import and export data, and to change job
settings such as displayed units, coordinate type, language & clearing layout flags for previously laid out
points.

You can also download projects from Trimble Connect and send the projects back to Trimble Connect in the
Projects screen.

Trimble Connect allows the project team to view, transform drawings and BIM data in your web browser
without running design software. Upload and share 3D and 2D documentation with the entire team including
SKP, DWG, DXF, PDF, Word, Excel, pictures, and videos with auto-archiving of all previous versions. You can
measure, create model clash reports, save markups and screenshots, and assign tasks to collaborators.
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Trimble FieldLink

Reports

Tap More H and then tap Reports to create and view a daily layout summary, layout deviation, field report
or report on surfaces collected.

Status Sharing

To show the progress of the various model components, Tap More H and then tap Status Sharing.

The Status Sharing tool can push progress information to Trimble Connect Desktop or Tekla software with
the installation of the Status Sharing extensions from those applications.

The Trimble Connect Sync Tool helps you keep a local copy of all your critical project data right on your
computer or automatically upload it to the cloud for safe storage. Once connected, you can upload or
download FieldLink jobs, models, point files, and reports from your Trimble Connect project when you have
Wi-Fi service. You may also be able to use your cell phone to create a Wi-Fi hotspot while out in the field,
depending on available cellular signal.

Creating a Trimble Connect project is quick, easy and free for a personal project with up to 10GB of data
storage. Training documentation, help files and more information can be found at connect.trimble.com.

System Information

In the FieldLink home screen, tap Morem to access system information including software license
information and software version.

Account Details

Tap Morﬂ and then tap Account Details to:
e seethe licenses that are assigned to you
* see how long until you must sign into the application again
e see when the licenses expire

e signout from the application

About

Tap More H and then tap About to access software information such as FieldLink Versions and Modules
installed, Device Firmware Version (when connected), Legal Notices, Tablet Serial Number, and Software
Support Expiration.

Minimize

Tap More H and then tap Minimize to minimize the software to the taskbar.
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Trimble FieldLink

Exit

Tap More H and then tap Exit to close the FieldLink software.
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Map

Tap More H and then tap Map to go to the map view of your model.

You can also move, scale, or rotate models and background files in FieldLink Office under Map.

Map Controls

The Map Control icons are shown along the right-hand side of the screen and allow you to navigate within the
existing project. Tap these icons once to activate the Map Control and tap again to disable the Map Control
option.

Zoom Extents and Preset Views

The Zoom Extents and Preset Views icon is used to set the map extent to include all objects in the job, get a
plan view, side view, or isometric view.

(®
(00006

1. Tapthe Arrow Button to the left of the Zoom Extents icon.

2. Select Zoom Extents, Isometric, Side View or Plan View button to change the project view to the
desired position.
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Map

Pan/Orbit

1. TapthePanicon: W& ..:
around the center of your pen or finger.

2. Tap the Orbiticon to change back to the Pan icon and mode. You can then hold
the existing view and move around the project in a fixed view.

Zoom

1. Tap/hold/slide the Zoom icon up or down to zoom in or out of the view.

2. Alternatively, use two fingers to pinch together or in/out figure gesture to zoom in/out.

Point List

Tap the Point List icon to create a point list for export, editing or layout sessions. You can
add points to the list by selecting them individually on the screen, using the Window or All Visible selection
tools. The point list can be created quickly by tapping on the Plus icon to filter by Name, Description or Layer.
To edit the list, tap the X icon to the right to delete points from the list, or select new points to add to the list.
To clear the list, tap the Clear icon. This icon is found under the Measure > Lay Out tool.
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Map

N

.,

Total: 0

To add points, select from map or use bulk add

Tap the Left Arrow icon to expand the point list and be able to review each point’s information including
layer, coordinates, staked information and attributes. This also allows you to sort the point list by Name,
Layer, Description, Delta Horizontally or Delta Vertically for staked points.

Sort by “
© ©
O 100 0 '
Attribute 1: —
Layer: 0
Attribute 2: ---
X: 307.325 ft
Attribute 3: -
Y: -53.694 ft
Attribute 4: ---
Z: 0.000 ft
Attribute 5: —
O 101 0 ﬂ
O 102 0 E
O 103 0 ﬂ
O 104 0 E
O 105 0 ﬂ
O 106 0 E
O 107 0 ﬂ
O 108 0 E
O 109 0
O 110 0 = E
O 1 0
O 112 0 E @
O 13 0 ( o‘
O 114 0 v |
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Map

Tap the Information Zipper icon to access the Information icon 0 , Map Settings icon @ , Layer icon°,
and the Section View icon @ .

Information

Tap the Informationicon o to see information about a selected point such as Name, Description, Layer,
and Coordinate Values. You can also press on straight linework to see the length and slope angle
information as well as arc information such as length, diameter and slope angle. If you have an IFC model,
you can also see the attached object information such as component name, size, volume or other
information attached to the model object in software such as Tekla or other BIM applications.

1.

I

Tap arrow to the left of the Information icon.
Select a point, line, arc, or object on the map.
Information is displayed on the map.

To close the Information Zipper, tap the Information icon G .

100 109

A DAD

N 100.000 ft
E 140.000 ft %
Z 100.000 ft
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Map

I‘A /“ ?E e

CREATE MEASURE DEVICE

% S.3D-BEAM

Length 43'95/16"
Slope 0.000 %
Model @
ReferenceObject:
GUID (MS) : becabdd4-
285¢-1029-0000-00000002216b
GUID (IFC) : 2yocKe! V5h

<
File Format i lfe
Common Type : BuildingElementProxy

CalrilatadCanmatndaliiac:

Map Settings

Tap the Informationicon o and then tap the Map Settings @ icon to make point information such as
Name, Description or Elevation visible on the screen.

The Map Settings panel includes the following options:
e Laid Out Points: Clear this check box to remove points from view once they have been laid out.
e Travel Direction Up: Select this check box to set the travel direction to up in layout mode.
e Scale Bar: Select this check box to add a scale bar to the map.
e Corner Bullseye: Select this check box to use corner bullseye mode.

e Solid Model: Select this check box to view solid models. Clear this check box to view wireframe
models.

You can also change the background color to white or black or you can make all linework blue for better
visibility in certain conditions.
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Map

Names

Descriptions

Elevations

L1 OO O

Laid Out Points

K

Travel Direction Up

Scale Bar

Corner Bullseye |:|

Solid Model

Map Display Options
1. Tapthe Arrow next to the Information icon o

2. Tapthe Map Settingsicon @

Make selections to display Point Name, Point Description, Point Elevation, Laid Out Points (If
unselected, points will disappear off the screen once they have been laid out), Travel Direction Up
(map rotates and updates as you walk to the point - Blue Diamond indicates travel direction), Scale
Bar, and Corner Bullseye (Shows a corner bullseye option and full map screen while laying out
points, lines or arcs).

4.  You can also change from Wireframe to Solid Model, and various levels of transparency for the
solid models.

5.  Change the Background Color to Black, White, White with all blue line work, or the arrow button to
cycle between various other color backgrounds.
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Map

6. The Points and Model icons allow you to toggle these options on or off. Yellow being on, white
being off.

7. To close the menu, tap the Map Settings icon ) .

Layer

Tap the Layericon o to view the list of available layers within the project and to display or hide individual
layers. When the layers list is visible, when you tap on the displayed linework or points in the plan view then
the associated layer name is highlighted in the layer list.

Layer Control

1. Tap the arrow next to the Information icon o .

2.  Tapthe Layericon o .

3. Select Layers to be displayed. You can tap on a line or item in the project to highlight a layer in the
list view, or tap on a layer in the list view to highlight a layer in the map view.

4.  Filter can be used to find layers containing specific text.
Tap the plus icon to create a new layer directly in the list view.

6. Tap the Filter icon to create custom layers with several layers displayed automatically.

7. Toclose the menu, tap the Layer icon o .

(%)
60 0
Filter (Contains) @ 0
A-DOOR-FRAM
ADOOR-GLAZ
AFLOR
AFURN
AGENM
AGLAZ-CURT ?
A-GLAZ-CWMG B
AWALL
/ Default
fii~ WAL EE
Q-CASE
S-BEAM
s-coLs
S-FNDN
S-STRS @
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Map

Save Layer View

To create a view that has specific layers turned on that you might use later:

1. Select the layers you want to view.

2.  Tap the Layer Viewicon e

3.  Enter a name for the view and tap Create.

The view is now available in the layer filter list for selection.

Level 3 Plan

Filter (Contains) @

0 & [i#
A-AREA t
A-CLNG ]
A-DETL el
A-DETL-GENF £l
A-DOOR ]

—

NOTE - You can replace existing Layer Views by creating a new Layer View and giving it the same name
as an existing Layer View with 6.0 release.
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Map

O FieldLink Office =X

0000000000
00000000
O(@@@@@@@QO

(- - )-)
(~ X X-)
(- Y- X-)
000

Section View

Tap the Section Viewicon @ to set a six-sided view cube to focus on a certain area, and also save those
section views.

1. Select the Section Box icon to activate the Section Creation box.

2. Tap the plusicon and then name the view.

3. Select the plus icon to activate the six-sided section box around the model.

4. Tap and hold on any of the six side arrows to push or pull the section pane to a certain area. This
section box will limit points created to the area within the box only.

5. Tap the Reset icon to take the Section cube to the original size.

6.  Tap the Edit icon to change the name or input Top and Bottom Elevations directly.

7. Tap the Section View layer or press the Plus icon to create a new section.

8.  Toclose this feature, tap the activated yellow section and then tap the Section View icon @ .
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Map

/L

MEASURE

H. Distance: ---
V. Distance: ---

SpE ==

hY r~

MEASURE

Section View
Building

Ceiling

Footings {
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Map

@ Trimble. Trimble Field Link —Ox

Section View Name  Section 1

SAVE

Top Elevation 38'61/8"

CANCEL

Bottom Elevation -56'2 13/16"

00000000000 0000
N/ N/ N/ N/ N/ NS N/ NS NS \__/ \_/ \_ \_/
(a) () (a) () (&) (n) () («)y () () (s) (s) (i)
NN NN NG N NG S N S N NN NI N
o/\ N N 7N 7N 7N 7N /\c N N N N
z ) [ x ) ((c) [ v ) (b ) (n) [(m ] ) (1) (2) (3) [(m )

N/ T/ /S /S S S NN, \_/

o - MNONONONGC

w ) { ) \ ) (. [(mm)

\ / N/ N\ /  \ \__/

o Bt OmE e B O  m

Model Management

Unzip the Information Zipper and then tap the Model Management icon to bring up a list of all
available models or background files within the project where you can display or hide these models. The
Model Management tool also allows you to transform, rotate and scale models and background files to fit
another model or background file with common points. This is possible with both FieldLink Office and Field
versions.

TFP DEMO Caissons LN <
TFP DEMO {=p (

From the Model Management tool you can also delete models/backgrounds files and edit, transform, and
rotate and scale models or background files.

1.  After selecting the Model Management icon, selecting one of the models from the list highlights that
model in the project. Select the pencil/edit icon to edit that model.
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Map

06

TFP DEMO Caissons

| TFP DEMO

Edit tools are shown that allow you to edit the selected model. You can rotate the highlighted model
with defined values or rotate and move the model anywhere in the project with the circular angle
tool and mouse wheel.

"YM‘“‘--E “

"L\‘%‘\ L

D Auto Snap

In the same page, there is an edit button that allows you to select a basepoint for the selected model
if desired. This edit button also allows you to change the angle incrementation and the scale factor if
desired.
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Map

Base Point Angle 90.00.000

(Incremental Angle)

Scale Factor 1.000

X: -49.975m

Y: 33.346 m

Z: 0.000m ‘ .
Back at the first edit page, there is also a button that allows you to lock both models and move them
simultaneously. This function doesn't allow for rotation.

= X: -49.975m 90.00.000

( './\ Y: 33346 m
~—"  z 0000m

The final functionality is the button that allows you to fit your model to another model using
common points in both models. Selecting the black/white icon brings you to a split screen with your
selected model and the secondary model. At the bottom of this page there are three check boxes.
One for auto snap which allows you to snap to points in both models, one for model scaling and
finally, one to enable preview of the model fitting. There is also a rotation button that only becomes
active after the 2 points have been selected in both models.
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Map

D Apply Scaling
D Auto Snap
D Enable Preview

Transform, Rotate, and Scale a Model to Another Model using 2/3 Points (Office
and Field)

To perform the model fitting from the split screen, select all three check boxes. For 2D model transformation,
select two common points between the models by selecting two points in your selected model, then selecting
the same two points in the second model. If the model appears to fit but is off by 180 degrees, apply the
rotate button at the bottom to rotate the model onto the other one. Once you are happy with the preview,
select Accept which will fit your model to the other one. If you wish to redo the model fitting, before you
select Accept, use the clear button in both models. For 3D model transformation, the same steps are applied
as mentioned above with the exception of selecting 3 common points between the models rather than two.

Y Apply Scaling N
@ Auto Snap ) ( acceer )

Enable Preview N _
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Map

Workslate Area

The Workslate is the portion of the screen containing user interface elements unique to the current Work
Mode.

<4
@
@ CREATE

The Input Form - Y is the area of the software where you enter in any numeric, alphabetic, or layer
information for the software to use. Input forms contain all variables that are used in the current Work
Mode. Each Work Mode has its own individual input form.

The Undo icon allows you to undo the last action taken such as creating, deleting or modifying points or
linework.

The Delete icon allows the user to delete any type of point, or to delete linework created within
FieldLink.

\ CREATE

The Createicon |

Bl . available in specific Job and Create Work Modes, allows you to finalize the
creation of items.

Map Tools

Tap the Clear All tool @ to clear all selected points, lines, and arcs from the map view.

Tap the Window Selection tool @ to drag and draw a boundary, which selects everything inside the
boundary for the current Work Mode.

The Current View tool @ is similar to the Window Selection tool, but you can use it to select everything
currently in view on the screen instead of drawing a boundary.

Compute Tools

Tap the Compute icon ° to access the distance, angle, area/volume, and down/out features. The
Compute mode is designed to assist you by providing easy access to basic tools to compute geometry
information from existing points.
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Map

Compute Distance

1. Tapthe Compute icon ° in the upper left corner.
2. Tap onthe Distance icon.

3.  Tap on the first point you need a measurement from. The first point you select is the starting point
(indicated by a solid blue circle).

4.  Tap on the second point for the measurement. The second point you select is the end point
(indicated by an open blue circle).

5. The measurement details between the two points are displayed in a yellow text box.

6.  Select another endpoint. The original start point remains.
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Map

1. To measure between two new points or to measure a new line segment distance, tap the
Clear icon.

2. To measure continuous line segments, you can select a third point and more after to obtain
individual and total line distances.

Individual and total line segments information will be displayed as follows:

Single Line Segment

H. Distance
SD
AX
AY
AZ

Azimuth

Multiple Line Segments

Total H. Distance
Total Slope SD
AX

AY

AZ

Compute Angle

Tap the Compute icon Q in the upper left corner.
Tap the Angle icon.

Tap the first point you need an angle measurement from. The first point you select is the starting
point (indicated by a solid blue circle).

Tap the second point for the measurement. The second point you select is the angle point (indicated
by a solid blue circle).

Tap the third point for the angle measurement. The third point you select is the end point (indicated
by an open blue circle).

The angle measurement between the three points appears in the lower message bar.

Select another endpoint. The original start point and angle point remains.
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7.

Map

To measure between three new points, tap the Clear icon.

Compute Area & Volume

—_

vk W

Tap the Compute icon ° in the upper left corner.

Tap the Area icon.

Tap the first point to outline the area you want to compute.
Tap the second point to outline the area you want to compute.

Tap the third point to outline the area you want to compute. The third point you select causes a
dotted blue line to be created between the start point and the third point and defines an area. Once
a three-point boundary has been established, the area and perimeter is shown in the lower message
bar.

Continue to tap on the additional points to outline the area you want to compute. Each point you
select causes a dotted blue line to be created between the start point and the last point selected.

If you accidentally select a point, tap on the point again to deselect the point. The last selected point
appears as an open blue circle. You can deselect as many points as necessary.

Tap the Input Form icon ) and enter a depth dimension.

The Area, Volume and Perimeter calculations are shown in the lower message bar.
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Map

10.  To start a new area calculation, tap the Clear icon.

Pinrmeler; JO0000

Down and Out Calculation

1. Tap the Compute icon 0 in the upper left corner.
2. Tapthe Down & Out icon.

3. Tap the first point of the line you need a measurement from. The first point you select is the starting
point of the line, and down measurement.

4.  Tap the second point of the line you need a measurement from. The second point you select defines
the line for the out measurement.

5.  Tap the third point to calculate the down and out measurement. The third point is indicated by an
open blue circle and attached to the main line with a perpendicular line.

6. Ifyou accidentally select a point, tap on the point again to deselect the point. The last selected point
appears as an open blue circle. You can deselect as many points as necessary.

7. The down and out measurement between the three points appears in the lower message bar.
8.  Select another point. The original line start point and end point remain.

9. To measure between three new points, tap the Clear icon.
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Projects

Projects

Tap More H and then tap Projects to open or create job files, import and export data, and to change job
settings such as displayed units, coordinate type, language & clearing layout flags for previously laid out
points.

You can also download projects from Trimble Connect and send the projects back to Trimble Connect in the
Projects screen.

Trimble Connect allows the project team to view, transform drawings and BIM data in your web browser
without running design software. Upload and share 3D and 2D documentation with the entire team including
SKP, DWG, DXF, PDF, Word, Excel, pictures, and videos with auto-archiving of all previous versions. You can
measure, create model clash reports, save markups and screenshots, and assign tasks to collaborators.

Create a New Project

1. Tap More H and then tap Projects.
2. Tap Manage.

3. Tap Create New G

Enter the Name.
2. Enter the Description (optional).
3. Add Layout Job and/or Scan Job (if enabled).

Layout Jobs and Scan Jobs are automatically generated based on the type of license you
have.

You can edit job names and delete jobs as you wish using the pencil and trash can icons next
to the job name.

4. Tap Open. The map opens.

Go to the Tree button to see file structure.
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Projects

Project Management

5/29/2023

#\ Points

Layout Job 1
Points:0 Lines:0

Arcs:0

N Scans

Scan Job 1
Stations:0 Groups:0

Unregistered:0

Create a TFLX File

Steps to create a TFLX file:

1. Use the Create tools in FieldLink to create points.
2. Convert an existing TFL file to TFLX.
3. Import a CSV or TXT file.
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Projects

Converting Existing TFL Files from Previous FieldLink

Versions

—_

Tap More H and then tap Projects.
Tap CONVERT .

Tap CONVERT.
ATFLX project is created and opened.

vk W

Navigate to and select the desired TFL file.

Layout Jobs and Scan Jobs are automatically generated based on the type of license you have.

Importing Files

1. Tap Moreicon H

2. Tap Projects and then tap Imports.

3. Navigate to and select the desired file.

NOTE - The File Explorer structure is different from previous versions of FieldLink. Projects have their

own folder within the FieldLink folder.
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Projects

» This PC *» Documents > FieldLink * Demo_Project_1

Mame

Points

Scans
D Demo_Project_1.flproj
D Demo_Project_1.settings

Alternative Workflow

Date modifi

5/9/2022 3.7
5/9/2022 3.
51272022 4
5/9/2022 3

When opening a new layout job or managing their jobs from the job management screen, you have the

opportunity to import a CSV, TXT or a TFLX file directly from this screen.

1. Tap the More icon H

2. Tap Projects and then tap Manage.

3. Under the current project, tap the Edit icon | Sg.

4.  Tapthe Import @ icon under the Models section.

5. Follow steps above for the regular workflow.

6. Tap Apply.

* For pdf/linked models, use More — Projects — Import @
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Projects

Exporting Data

1. Open the project.

2. Select the points on the map that you wish to export.

Tap More H and then tap Projects.
Tap Export.

Select the file type and export location.

3.
4.
5.
6.

' NOTE - When exporting points and lines in DWG format, the layer structure is retained.

File Type - Export Point Location - / )
O owe QO skp @ Design 0 ( EXPORT

Tap Export.

@ v O xisx QO staked

Export TFLX

You can export TFLX files from the export screen or from the project management screen.

Export TFLX from the Export screen

A

MEASURE sa Device MORE

Jeo 0 ©

File Type 3 EXPORT

( TRx A) N " !
N ~ [[] staked only

1. Inthe Export screen, select TFLX from the drop-down list on the left.

2. Select the Staked Only checkbox to export only staked point locations. To export both staked and
design locations, clear the Staked Only checkbox.

3.  Tap the Edit icon, and then select the export location.

4.  Tap the Export button in the bottom right corner of the screen to export the TFLX file.
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Projects

EXPORT

D Staked Only

Once you have selected the desired export format and point locations, you may then tap the Edit icon n to
select a desired export location.

Finally once a location has been selected, you can now tap the Export button on the bottom right
hand side of the screen to export the TLFX file.

Export TFLX from the Project Management screen

1.

ook W

7.
8.

Open your project.

Tap the points on the map that you wish to export.
Tap More, and then tap Projects.

Tap Manage.

Select the project that has the TFLX file you wish to export and tap the Edit icon to begin.

DerekKrish Test #

Layout ob 1tesr 5/22/2025 ¢
. Scanjob 1 =
CurrentWork : ereyycisn restexpor.a

FOOTING EXCAVATION.dwg,

The project edit window opens.

4
—A

-
° DerekKrish Test
ZZZZZZZZZ

Jira Testing Layout ° @
Layout Job 1test ° @
Points:1869 Lines:978 Arcsi0 Staked Points:8

Layout Job 2 0 @

Tap the TFLX point job that you want to export and tap the Export icon @

Select the desired location and tap Save.
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Export Staked vs Design (CSV/XLSX)

1. Open your project.

Select the points on the map that you wish to export.
Tap More, and then tap Projects.

Tap Export.

vk W

Select the CSV or the XLSX file type. The following options appear when CSV or XLSX file types are
chosen from the drop down menu.

Export Point Location
File Type @ Design

O Staked Only
O Legacy (Staked over Design)

Select what to export from the following options:
e Design - Selected Design Locations will be exported.
e Staked - Selected Staked Point Locations will be exported.
e Legacy (Staked over Design):
e If not staked, the design location will be exported.
e If staked, the staked location will be exported.
e If control, the design location will be exported regardless of stake status.
Tap the Edit icon [ ) to select the export file location.
Tap the Export button on the bottom right hand side of the screen to export the CSV or XLSX file.

Supported Files for Export

o dwg

* skp

e CSV

e Xlsx

o tzf/tcf
e tdx

e pod

o las

e laz

e rcp - structured

° rcp - non structured
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e e57-structured

e e57-non structured

Managing a Project

1. Tap More H and then tap Projects.
2. Tap Manage.

3.  Select a project and tap Open.

C FieldLink Office

Current

n Test Feb 4 —
Job converted from FieldLink

-
[
@

Demo_Project 1 /°
Layout si0r2002 Yo
CurrentWork : (Fmpry) =

D Home Office Test o e
Job converted from FieldLink A5

DELETE

4.  Create or add point, scan, and model job files.

C FieldLink Office _ X

[ oren )

To Create @or Import '@a points file, select the appropriate icon.

6. The created points file is a .tflx and can be found in the project's Points folder (see Importing Files,
page 31).

7. Once files are added, tap Open.

Points, scans, and models can be accessed using the Tree icon & on the left side of the screen.
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-

Demo_Project_1 =
¥ Points

Layout Job 1 @
¥ Scans

Scan Job 1 @
» Models

Deleting Job Files

To delete either a points, scans, or models job file, make sure the job is not highlighted yellow (meaning it is
not active in the project) and once grayed out, a trash can will appear on the far right side of the job file. Tap

the Delete icon and then tap Yes to confirm.

Job Settings

Setting of the project including the Distance Units, Coordinate Order, Language and Clear Layout Flags
can be modified under Projects.

1.
2.

Tap the Morem icon.

Tap Project and then tap Settings.
Select the Distance Units:
e Select Meters to show distances using metric units.
. Select Feet to show measurements in decimal feet.
¢  Select Feet-Inch (1/16") to show measurements to the closest 1/16".

Select the Coordinate Order to define how points are imported or exported. Depending on the type
of software used to create or import points, the points may need to be in (X,Y,Z) or (N,E,Z)= (Northing
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(Y), Easting (X), Elevation (Z).

5. Several different languages are also available including English, Spanish, French, Dutch, German,
Italian, Portuguese, Japanese, Korean and Simplified Chinese.

6. Toreuse the layout point locations without the attributed detail of the already positioned data then
you can tap on the Clear Layout Flags button.
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“
Tap Create . to create, modify or delete project data including a plan view of a project, linework, points,
points from a model, grid points or point patterns.

Pointwork

In Pointwork mode, you can view point information, add, edit or delete points, or specify select points as
control points. You also can create points along a line or arc, or offset points along a line or arc to either or
both sides of the line or arc.

In Pointwork mode, you can:
e Input Point, page 40
*  Create Point Anywhere, page 41
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Single Point Offset, page 41

Create Multiple Offset Points - Line, page 42
Create Multiple Offset Points - Arc, page 42
Create Point - In Wall, page 43

Point Manager, page 44

Input Point

11.

12.

Tap the Create icon B .

Select Point Manager.

Tap the Input Form icon

Input the Name, Description, Layer, X (Easting), Y (Northing), and Z (Elevation) of the point that
will be created. Place the points on a specific layer by tapping the Layer drop-down menu, or type in
a new Layer to create a new layer name.

Checking the box next to Control Point will mark the point with a triangle in the middle of the point
to signify it is a Control Point.

Tap the Create icon .

C FieldLink Office _ X

Demo_Project_1 #
u Layout s/972022 ¥

CurrentWork : (Empty) =
Home Office Test
Job converted from FieldLink

No Favorite Folders/Files

To edit a single point or multiple points, tap on one of the existing points to highlight it in blue or use
the Window Selection tool.

Use the Map Tools to zoom in on an area, zoom extents, turn on/off layers, or otherwise define a
single or group of points to edit simultaneously.

Unselect the point by tapping it again or tap the Clear All icon to unselect all points.

Tap the Input Form icon. You can change the Description, Layer, Z(Elevation), or make them
Control Points. You can change the X(Easting), Y(Northing) only for single points at a time.

If you edit the Name of an existing point, the Name reverts to the next number available in the
sequence and the position values, layer and description are the same as the selected point. This
process is similar to a “Save As” function.

Tap the Apply Edits icon.
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13.  You can delete single or multiple points by selecting the point and tapping the Delete icon.

14.  Toundo the last creation, edit or delete process, tap the Undo Arrow

Create Point Anywhere

1.  Tapthe Create Point Anywhere icon H and then tap the screen where you want to place the point.
You should only use this option when no background option will work or for temporary points.

2. You can then edit this point using the Input Form :

[ creaTE |

TIP - Use the Create Point Anywhere tool along with the scanning module to create layout points
along building corners, wall lines or other recognizable scanned objects.

Single Point Offset

1. Tapthe Line Offset Point icon and select the start and end point of the line you want to offset or
create points along.

2. Select the Single Mode option.
Select two points to define the direction.

4.  Tap the Input Form icon and enter values for Horizontal Offset, Vertical Offset, Start
Distance, Name, Description and Select or Enter Layer. Tap the Input Form icon to return to map
to check the location of point that will be created.

5. Tap Create.

(®
9" e
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Create Multiple Offset Points - Line

1.

Create Mode

Tap the Line Offset Point icon and select the start and end point of the line you want to offset or

create points along.

Select the Multiple Mode option.

Tap the Input Form icon . Input the Name, Description, Layer, Offset Distance (Can be “0" if
you want points along the line), Interval (Distance between points along the line), and Start
Distance (First point off the first point you selected). The elevation of the offset points will be
determined by the Z(Elevation) of the points selected for the start and end points of the line. Place
the points on a specific layer by tapping the Layer drop-down menu, or type in a new Layer to create

a new layer name.

Tap the Offset Direction icon to toggle from right, left or both sides of the line before creating

points.

Tap Create.

Create Multiple Offset Points - Arc

1.

Tap the Arc Offset Point icon and select the start and end point of the arc you want to offset or

create points along.

Tap the Input Form icon. Input the Name, Description, Layer, Offset Distance (Can be “0" if you
want points along the arc), Interval (Distance between points along the arc), and Start Distance
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(First point off the first point you selected). The elevation of the offset points will be determined by
the Z(Elevation) of the points selected for the start and end points of the arc. Place the points on a

specific layer by tapping the Layer drop-down menu, or type in a new Layer to create a new layer
name.

3. Tap the Short Arc/Long Arc icon to switch the new arc from the short arc solution to the long arc
solution.

4.  Tap the Flip Arcicon to switch the direction of the arc.

Tap the Offset Direction icon to toggle from right, left or both sides of the line before creating
points.

6. Tap Create.

To undo the last creation, edit or delete process, tap the Undo Arrow

o (®
o]
0 ©
o
(o]
w ]
o o @
o]
o]

Create Point - In Wall

1.  Tap the Create Point in Wall icon.
2. Select the two lines that define the wall.

3.  Tap the location between the lines where you want to create the point.

4. Tap the Input Form icon =4 . Input the Name, Description, Layer (Place the points on a specific
layer by tapping the Layer drop-down menu, or type in a new Layer to create a new layer name).
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Create Mode

Tap Create.

Point Manager

For location, review and editing of point data, the FieldLink Point Manager enables you to create a list based
on map selection or by specific filter fields. A selected point in list is highlighted in the map view.

1.
2.

Tap the Point Filter icon.

To populate the list either select points individually on the map area, multi-select points using the
multi-select tool, or tap on the plus icon to populate the list by a filter selection (name, description,
layer, design points, control points).

To review details of a point, tap on the left face arrow to expand the list.

You can arrange the order of the list by selecting the Sort By drop-down. Sort by name, description,
layer, delta H and delta V.

To review the details of a point, tap the down arrow.

You can make edits to points by using the Enter Form. If you want to change a point name, you need
to select the point, enter the new name, then tap Create. FieldLink will keep the original point, or you
can delete it if no longer needed.

If you select a point in the list, it is highlighted in the map area.
To clear the list, tap the Clear icon.
NOTE - If you have more than a single point in the list or selected on the screen, then edits are

made to all the selected points. When editing multiple points, you can only change the elevation,
description, layer, and attributes.
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Plan

Use Plan mode to create a series of points and linework to draw out the desired floor plan, add linework to
an existing 2D plan or 3D model, or create offset points and linework to any existing points or linework.
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11.
12.

Create Mode

Tap the Create icon B and then tap Plan.

Tap the Input Form icon .

Input the Name, Description, and Layer for the first point. Also input the Distance, Angle and
Elevation of the line from the first point.

NOTE - The default coordinates for the first point will be 100 (X), 100 (Y), and 10 (Z). The default
distance from the first point is 10 m (32.808’) and the angle is 0.00.00 degrees from plan North.
If you want to designate a different origin point, see Linework, page 47, and create the origin
point using the Input Form under the Points workslate.

If you created an alternate origin point, set that point as the beginning of the linework by tapping the

Input Form 8 icon again and returning to the map view and selecting the point.

Tap Create.

Distance 32.808 ft Name 101

Angle 0.00.00 Description

Elevation 0.000 ft Layer 0

To create the next line, tap the Angle icon to toggle between the three preset angles, 30, 45 and 90
degrees to quickly draw your plan.

Use the Left or Right toggle icons to move the next point and linework to the selected angle from
plan North.

If you do not want a line created between the points, you can uncheck the box next to Line as you
draw the plan to create only points.

Using the Input Form, you can input any Angle, Distance, Point Name, Description, Elevation or
Layer for the new points and linework.

Tap CREATE if the selected point and linework is in the correct location.
To undo any point or line work creation, tap the Undo Arrow.

You can always add, edit or delete points or linework in Point Mode or Linework Mode created or
needed within the plan.
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Linework

The Linework workslate enables you to create lines or arcs between design or as-built points. You can also
edit or delete collected or created linework using this tool.

To use the Linework workslate, tap Createﬂ and then tap Linework.

e Ifyou need to delete a line or arc, tap the linework on the screen and tap the Delete icon.

e Toundo the creation or deletion of linework, tap the Undo Arrow.
In Linework mode, you can:

e Create a Straight Line, page 48

e Create an Arc, page 48

e Create a Segment, page 49

e OffsetaLine, page 49
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Create a Straight Line

1. Tapthe Lineicon to create a straight line.

2. Tap the points to connect with linework. You can select multiple points in sequence to draw a
straight polyline through the points as selected.

3. TapCreate.

Create an Arc

1. Tapthe Arcicon.

2. Select two points to be linked with the arc. The arc, center point, and radius point are shown on the
screen.

3. Tap the Input Form icon to type in a Radius Length. The current radius is displayed next to the
Input Form icon.

4,  Tap the Short Arc/Long Arc toggle icon to change the radial length.
Tap the Flip Arc icon to change the radius point to the opposite side.

6. Tap Create. The arc, center point and radius point are created using the point name, description and
layer as the two arc points originally selected.
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Create a Segment

1. Tapthe Segmenticon.
2. Select the newly created or imported line or arc you would like to segment with points.

3. Tap the Input Form icon[gJ] to type in the segment points Name, Description, Layer, and Segment
Length. The current segment length is displayed next to the Input Form icon.

4,  Tap on the Flip Start icon to change the start point for the segment points.
Tap Create . The arc, center point, and radius point are created using the point name, description
and layer as the two arc points originally selected.

6. Toundo the segment points, tap the Undo Arrow.

I -
= (@
©

()

Offset a Line

Tap the Line Offset icon.

—_

Tap the line you would like to offset.

If you want to change the offset value, select the Input Forrrn and apply the change.

R

Select the Offset Direction icon to change the side on which the offset line will lie from the original
line.

5. Tap Create to create the offset line.

@&
® @
@&
& @
©

Trimble FieldLink User Guide| 49



Create Mode

From Model

Use the Create From Model tool to create points from a 2D plan, 3D model or linework created in TFL, using
the predefined snap options after importing the model (see Create a TFLX File, page 30).

NOTE - For FieldLink version 4.x, you can layout directly from imported or created linework by tapping
on the linework, without creating any points on the line. This functionality may greatly reduce the need
to create many points if you are staking to linework. You must still tap the stake icon to store the point
for future reference, QA and documentation processes.

1.
2.

Tap the Layer icon @) and then tap any of the linework you would like to isolate. The selected layer
is highlighted in the map view and layer list so that you can tap the None icon, then check next to the
single or multiple layers you want to create points upon.

Select the required snaps by tapping in the open selection box. Current options are End Point, Mid
Point, Circle/Arc Center, Intersection, Center From 3 Points or Apparent Intersections.

NOTE - If using Apparent Intersections Drag and Current View options are disabled.

[ enpains
=

Tap the Input Form icon . Input the Point Name, Description, and Layer for the first point. Tap
the Input Form icon again to view the points on the map view before creation.

Tap on each location you would like to create a point using the selected snap, or use the Map Tools
icons including Selection Box or Current View tools to create multiple points quickly.

Tap the Clear All icon to clear the selected points if you made any mistakes in your selections.

The number of points to be created is shown under the Create button. Tap Create to finalize the
points.

To undo the creation, tap the Undo Arrow.

Once points are created, you can delete or edit the points within the Points Workslate (See
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Pointwork, page 39).

N\ » -

(000

@
e
@ "

NOTE - If you are creating points with a 3D model, you may end up with multiple points on top of each
otherin a 2D view (e.g. if you are looking at a column structure from above you will create 2 points
instead of one for upper and lower corners).

for easy viewing during layout, or exporting/importing field data into or from the office.

I TIP - Use letters, numbering, descriptions and layers when creating points to help filter or sort points

Grid

In the Grid work mode, you can create points on a specified grid pattern with defined point names,
descriptions and layers.

1.
2.
3.

Tap the Createicon B and then tap Grid.
Tap the Input Formicon[g})] .

Input the values for each of the fields. The Start N(X) and Start E(Y) will position the first grid point
at that location and defaults to 100(X), 100(Y), or select the starting point from the map view.

Input the Point Name and Description.
Input the number of grid Columns and Rows.

Input the Width (distance between the grid Columns), and the Height (distance between the grid
Rows).

Place the points on a specific layer by tapping the Layer drop-down menu, or type in a new layer to
create a new layer name.

Tap the Input Form icon again to view the points on the map view before creation if desired.

Tap Create to finalize the grid points.
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11.

Create Mode

To modify the values or undo the creation, tap the Undo Arrow.

St N 100.000 ft @ suneioomn Nama GO100

Columes 3 O o3 Description GRID

Width 5,000 ft ° Hesght 5.000 ft Qm anip =]

Use the Map Controls icons including the Zoom Extents, Zoom Slider Bar, Point Information,
Map Settings and Layer icons to isolate an area or layer for viewing, or to show the point layer,
description, and elevation information.

Pattern

Point patterns help with the creation of points that repeat numerous times and can be centered around
another point such as anchor bolts, offsets, hangers, etc. You can also share these point patterns with other
FieldLink users.

For a New Pattern

1.

w

N o Uk

Tap Create and then tap Pattern.
Tap the Input Form icon and enter the X and Y values.

You can also enter the grid spacing to be able to select background grid intersections directly on the
screen.

To view the location of the point on the map screen, tap the Input Form icon again.
Tap directly on the grid intersections to temporarily create additional points.
Tap Add Point(s). Repeat to add more points to the pattern.

To save the pattern, tap Save Pattern, enter name and tap Save Pattern.
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X-1.000 ft Row Spsmng)

Y-1.000 ft Col. Spacing n

For an Existing Pattern

1.  Tap Edit Pattern. You may have to tap Clear Pattern if you don't see the pattern you wish to edit.
2. Select the pattern from the file location. Tap Load Pattern.

3. Toedit the pattern, tap a point in the pattern and then tap the Input Form icon [§J)] to change the X
and Y values. Tap Save Point.

4. Tap Save Pattern.
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To Place the Pattern

—_

> W

Tap the Point icon and then tap Select Pattern.

Select the pattern from the file list and then tap Load Pattern.

Select the center point(s) on the map screen where you want the pattern to be created.

To rotate the pattern, select from the Preset Angles or tap the Input Form[€}] icon to typein a

specific angle. Also, you can enter the starting point name, description and select/enter the model
layer.

Tap Create.
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Tap Measure n to:

e Layout points, lines, offsets, arcs

e Collect points, lines, arcs or to auto collect square cateye control points
e Lay out wall penetrations

e Layoutplanes

e Collect and lay out surfaces

e Change measurement settings such as tolerances, next or nearest points, Visual Layout or Standard
Laser mode, and High Precision or Fast Precision.
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Measure Settings

1.  Tap Measure i and then tap Settings. The layout settings icon is highlighted.

2. Tap the H. (Horizontal) Tolerance arrow to select from 1", %", %", 1/8" or 1/16", or 25,12, 6, 3,
1.5mm. Alternatively, you can choose the Custom Tolerance option and enter the desired
measurement.

Points measured in the field that are outside this tolerance setting have a red lay out flag on the
screen indicating the point was out of tolerance.

3. Tapthe V. (Vertical) Tolerance arrow to select from 17, %2", %", 1/8", 1/16", or Ignore, or 25,12, 6, 3,
1.5mm. Alternatively you can choose the Custom Tolerance option and enter in your desired
measurement.

Points measured in the field that are outside this tolerance setting have a red lay out flag on the
screen indicating the point was out of tolerance. If you select Ignore, vertical elevation
measurements are used for tolerance flags.

Horizontal Tolerance Vertical Tolerance
. ®
O 0.188in O 0.188in

(Should not be less than 1/16") (Should not be less than 1/167)

4.  Select on the Next or Nearest layout selection box to automatically select the next sequential point
(ex. 100, 101, 102, 103) or the Nearest point to the prism or LASER measurement. The Nearest
setting is usually the most efficient.

5. Tap the Measure Settings button.
a. Select Standard or Visual Layout for Laser Aiming.

Standard mode aims the laser beam at the X, Y, Z location and gives correction distances.
Visual Layout mode moves the laser beam to the correct X, Y location based upon the
adjusted elevation.

b.  Select High Precision or Fast Precision Measure Mode.

High Precision takes an average of the measurements over a few seconds. Fast Precision
takes an instant measurement.
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Collect

Once the Instrument Set Up has been completed, you can collect and/or lay out without performing
another Instrument Set Up. See Connection, page 77for instructions on Instrument Set Up.

Use the Collect Points process to save project information such as existing utilities, foundations, anchor
bolts, or any other type of project information. Use the Collect Linework process to save information such
as ceiling or floor lines, inside and outside building corners, doorways, windows, utilities or any other type of
linework information to help save time by creating drawings or 3D model information automatically in the

field.

You can use FieldLink to:

Collect, page 57

Collect Line, page 58

Collect Arc, page 59

Collect Circle, page 60

Collect Points Using Rounds (optional), page 60

Collect Points

o vk W

Tap Measure il and then tap Collect. The pointicon is automatically selected.

Tap the Input Form icon . Input the Point Name and Description. Place the points on a specific
layer by tapping the Layer drop down menu, or type in a new layer to create a new layer name.

If you are measuring a control point, select the Control Point check box.
Tap the Camera icon (o)) to capture and store image with the point.
Use the Joystick or Vision modes to aim at the item or prism.

Place the prism rod on the point or aim the laser directly at the item to measure and tap the Shoot

icon. The prism or laser position is displayed with the "% g symbol in Map View.

When ready to collect square cateye targets to be used for autostationing, make sure the control
point is selected and tap Auto Collect. This is only available when using a RPT600. To manually
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change points to control points, see Linework, page 47.

Name 202
Description Door

Layer A-DOOR-FRAM e

Collect Line

1.  Tapthe Line icon to measure points and create lines between each point as you measure.

2. Tap the Input Form icon . Input the Point Name and Description. Place the points on a specific
layer by tapping the Layer drop down menu, or type in a new Layer to create a new layer name.

3. Select the points and lines to be collected as Measured, Design, or Control. Measured points and
lines are indicated with a solid dark circle and cannot be laid out without saving the point under a
different name. Design points are indicated with an open circle and can be laid out again
immediately. Control points are indicated with a triangle inside an open circle.

4.  Use the Joystick or Vision modes to aim at the item or prism.

Place the prism rod on the point or aim the laser directly at the item to measure and tap the Shoot
icon.

6. Tapthe Close Line [®) icon on the screen to automatically create a line to close the line segments.

7. Points or lines that have been collected as Design points can be connected to other points or
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connected with linework using the Create Linework mode.

Collect Arc

1. Tapon the Arcicon.

2. Tap the Input Form icon. Input the Point Name and Description. Place the points on a specific
layer by tapping the Layer drop down menu, or type in a new Layer to create a new layer name.

3. Measure three points that define the arc. You will see the arc being constructed as you capture the
first two points then when the final point is captured the arc is finalized and shown on the map
display. The Arc Diameter and Arc Angle are indicated during collection.
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Collect Circle

Tap on the Arc icon and then tap the Circle option box.

Tap the Input Form icon. Input the Point Name and Description. Place the points on a specific
layer by tapping the Layer drop down menu, or type in a new Layer to create a new layer name.

Measure three points that define the arc. You will see the arc being constructed as you capture the
first two points then when the final point is captured the arc is finalized and shown on the map
display. The Arc Diameter and Arc Angle are indicated during collection.

Collect Points Using Rounds (optional)

To use Rounds you must have purchased the Site Control Module.

1.
2.

Tap Measure [l and then tap Collect. The pointicon is automatically selected.

Select the Rounds boxes and the Face Order, Number of Rounds, and Measure Mode. Also select
the Control box before running the Rounds routine.

The results of the Rounds process is shown in the bottom of the screen.

Measuring with: 360 Prism
Max A HA: 0° 00' 00"

Max A VA: 0° 00' 00"

Max 4 SD: 0.000 m

Round 1 0f 2, F1.

Layout

You can use FieldLink to lay out points created with office software and transferred to the field. You can also
lay out points you create in the field, or lay out lines by selecting points.

Layout, page 60

Lay Out Line, page 64

Lay Out to a Line, page 65

Lay Out Arc, page 65

3D Perspective Model View, page 67
Create Points - Lay Out Line, page 67

Lay Out Points

Points can be created within FieldLink or with office software such as Vico, Tekla, SketchUp, Trimble Business
Center, Trimble Field Points for AutoCAD or Revit, or even other non-Trimble software. The points measured
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should be compared to the model to ensure any deviations, changes or issues are documented in the as-built
model or drawings.

1.

2.

Tap Measure i and then tap Lay Out. The Point icon is automatically selected.

You can isolate points by selecting the appropriate layer under the Layer icon ° or by pressing
the Point List icon @) in the lower left and using the Point Filter options to create a point list for
your layout session.

Tap on the first point you need to lay out. If there are multiple points on top of one another or close
together, a point selection box appears in the lower left corner and you can select the correct point.

The Direction Bar at the top indicates back or forward to the RTS, left or right as you are looking at
the RTS, and up or down to the correct elevation. You can toggle the direction bar to give
horizontal/vertical changes or the Back/Forward, Left/Right, Up/Down bar.
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You also now have the option to select the Corner Bullseye to display on the screen under Map
Options. If you have a point list created, you can also look at point information including position,
layer and attributes for each point.

If you are in laser mode, the RTS automatically aims at the point as soon as you tap on the point. If
using Visual Layout as checked in the Measurement Settings, the laser beam moves to the correct
X, Y position and shows any vertical deviation in the lower dialogue bar.

Once you are within approximately 3' (1 meter) from the point, the screen automatically changes to a
bullseye mode. You can change back to the plan view by tapping the Bullseye icon.
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Measure Mode

If the laser fails to measure after three attempts, but is very close, you have the option to maneuver

the laser manually with the joystick features and or the nudge buttons.

Tap the Next arrow icon to advance to the next point if you do not want to store the as-built
information for future use and quality assurance.

Tap the Shoot icon to collect the as-built information and store this information for future use and
quality assurance.

Tap the Next arrow icon to advance to the next or nearest point as selected in the Measure Settings,
page 56.

The lower message bar appears giving the staked point information. Points measured within the
tolerance settings appear as green check marks. Points outside of tolerance settings appear as a red
X.

Point Layout List

If you have the 3D Feature Pack then you can generate a point layout list. The list can be populated by
selecting individual points on the screen, multiple selections with a window or using a filter by name,
description or layer.

l NOTE - When using the functionality filter layer with points, only layers that include points are visible.
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To create a point layout list:

1.  Tapthe Point Layout List icon.
2. Populate list via:
*  Point selection on map
e Multiple selection with window selection
e TapAdd icon enter by Name, Description, or Layer
3. Toclear the list, tap the Cancel icon.
4.  To layout with list, tap the Layout icon.
5. Toadvance to nextin list, use Arrow.
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Point Transfer

There may be times when you are unable to lay out on the floor because there are obstacles in the way. This
feature allows you to switch between layout on the floor and the ceiling.

1. Tap Measure and then tap Lay Out.

2. Tap the Transfer icon [@J) at the lower part of the screen.
3.  Follow the prompt to aim at either the floor or ceiling for a reference elevation. Then you can layout
the point you want to transfer.
4.

You can then keep tapping on the Transfer icon to switch between floor and ceiling.
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Lay Out Line

FieldLink provides the ability to layout linework by selecting 2 points to define a line segment or multiple
points to define a polyline. Any temporary offset or interval points created in this section will not remain in
the database until they are actually measured.

1.

> W

10.

11.

12.

13.

14.

Tap the Measure icon and then tap Lay Out.
Tap the Line icon at the lower left of the screen.
Tap the Clear Selection icon to select new points.

Tap on two points to create the blue line to be staked. You can tap on additional points to offset a
polyline around a building or utility run.

Tap the Input Form to create an Offset Distance, Interval Distance, Start Distance, Name,
Description and Layer of the points to be laid out along the line. You can enter “0” for the Interval
Distance to take measurements along the line or offset line directly.

Tap the Input Form again to see the temporarily created points represented as open blue circles on
the plan view to ensure the correct locations.

Tap the Left/Right/Both Sides icon to toggle the offset points on either or both sides of the line.
Tap on the first point to be measured if you entered an Interval Distance.

The Direction Bar at the top indicates back or forward to the RTS, left or right as you are looking at
the RTS, and up or down to the correct elevation. You can toggle the direction bar to give down and
offset positions or the Back/Forward, Left/Right, Up/Down bar.

If you are in laser mode, the RTS automatically aims at the point as soon as you tap on the point. If
using Visual Layout, as checked in the Measure Settings, page 56, the laser beam moves to the
correct X, Y position and shows any vertical deviation on the right-hand side of the screen.

Once you are within approximately 3' (1 meter) from the point, the screen automatically changes to a
bullseye mode. You can change back to the plan view by tapping the Bullseye icon.

Tap the Shoot icon to collect the as-built information and store this information for future use and
quality assurance.

Tap the Next arrow icon to advance to the next or nearest point as selected in the Measure Settings,
page 56.

The lower message bar appears giving the staked point information.
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Lay Out to a Line

FieldLink provides the ability to layout linework and offset lines with Down and Out measurements by
selecting only two points to define the line. This method is a quick and easy way to stake a continuous line
anywhere on the line.

1.

Tap Measure i and then tap Select Lay Out.

2. Tap the Offset Line icon at the lower left of the screen.

3 Tap the Clear Selection icon to select new points.

4,  Tap on two points to create the blue line to be staked.

5.  Tapthe Input Form (&) to create an Offset Distance, Name, Description and Layer of any points
to be laid out along the line. You can enter “0” for the Offset Distance and take measures along the
line directly.

6. Tap the Input Form again to see the temporarily created line represented as a solid blue line on the
plan view to ensure the correct location.

7.  Tap the Left/Right/Both Sides icon to toggle the offset line on either or both sides of the line.

8.  The Direction Bar at the top indicates down and offset positions. The down dimension is from the
first point you selected to create the line, the offset distance is given as a right or left if you were
standing at the first point you selected and are looking towards the line end point.

9. Tap the Measure icon to collect the as-built information and store this information for future use
and quality assurance.

10.  The lower message bar appears giving the staked point information. Points measured within the
tolerance settings appear as green check marks. Points outside of tolerance settings appear as a red
X.
Lay Out Arc

1.  Tap Measure i and then select Lay Out.

2. Tapthe Arcicon at the lower left of the screen.

3. Tap ontwo points to create the blue arc to be staked.

4.  To select new points, tap the Clear Selection icon.

5. Tap the Input Form to create an Offset Distance, Interval Distance, Start Distance, Radius,
Name, Description and Layer of any points to be laid out along the arc. You can enter “0” for the
Interval Distance to take measures along the arc or offset arc directly.

6. Tapthe Input Form again to see the temporarily created arc represented as a solid blue line on the
plan view to ensure the correct location.

7. Tap on the Short Arc/Long Arc toggle icon to change the arc from the shortest distance along the
arc to the longest distance along the arc.

8. Tap onthe Reverse Arc icon to change the direction of the arc.
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Measure Mode

Tap the Left/Right/Both Sides icon to toggle the offset line on either or both sides of the line.

0\ 0
o I

If you entered an Interval Distance, tap on the first point to be measured.

The Direction Bar at the top indicate back or forward to the RTS, left or right as you are looking at
the RTS, and up or down to the correct elevation. You can toggle the direction bar to give down and
offset positions or the Back/Forward, Left/Right, Up/Down bar.

If you are in laser mode, the RTS automatically aims at the point as soon as you tap on the point. If
using Visual Layout as checked in the Measurement Settings, the laser beam moves to the correct
X, Y position and shows any vertical deviation on the right-hand side of the screen.

Once you are within approximately 3' (1 meter) from the point, the screen automatically changes to a
bullseye mode. You can change back to the plan view by tapping the Bullseye icon.

Tap the Shoot icon to collect the as-built information and store this information for future use and
quality assurance.

The lower message bar appears giving the staked point information. Points measured within the
tolerance settings appear as green check marks. Points outside of tolerance settings appear as a red
X.

Tap the Next arrow icon to advance to the Next or Nearest point as selected in the Measure
Settings, page 56.
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3D Perspective Model View

1. Tapthe arrow next to the Bullseye icon.
2. Tap the Prismicon.

3. The 3D Perspective Model View is displayed, as viewed within the model showing the position of
the prism on pole or laser point if in Laser mode, the instrument location and relationship to the
point being laid out.

4.  Directions are displayed, view & directions update as you move to the point selected.

TIP - Use of Feature Codes sets such as AB for Anchor Bolts, TR for Tree, TBC for Top Back of
Curb, can help the field and office team understand collected and lay out items faster and
easier. Feature Codes can also help save time in the office by automatically creating drawings or
3D model information in certain software.

NOTE - Make sure to check the backsight or stake control points periodically to ensure the
instrument has not shifted locations due to settlement, thermal changes, or interference.

Create Points - Lay Out Line

—_

Tap Measure [l and then tap Lay Out.
Select two points that define the line.
Tap the Input Form L) icon.

A W

Input Offset, Interval, Start Distance, Name, Description and Layer.
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5. Tap Create to add points.
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Measure Mode

Select two points that define the object to penetrate the wall or, select an existing line.

The laser points to the location on the vector between the two points that intersects the wall.

1.  Tapthe Measure icon i and then tap Wall Penetrations.

2.

3. Tapthe Aimicon.

4.

5. Youcan use the Input Form icon to define offsets for left, right, up and down.
6.  You can then apply these offsets to the penetration.

NOTE - When selecting an existing line or two points to define a line, FieldLink automatically extends the
line .5 of a meter in both directions to ensure that the selected line penetrates through the wall to

ensure use of the feature.
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w/ Laser pointing to penesration locatian

Surface (Optional Module)

FieldLink can accurately define the low and high areas of a horizontal or vertical surface whether it is the
floor, ceiling or wall via the use of the Surface Module. The first step is to define and measure the surface,
then, FieldLink can calculate the low and high contours based on a reference elevation and a tolerance. You
are then able to layout the location of these contours. You can generate a report based the information
collected.

NOTE -

e The Surface module works with .xml files only.

e The Surface module is included with FieldLink Core Subscriptions.

Define and Measure the Surface Area

1. Tapthe Measure icon i and then tap Surface.
2. Tap the Fence icon on the right of the screen to add a new surface.

Tap the plus icon to enter and select the details of the surface: name, horizontal or vertical surface,
and layer.

4.  Toreturn to the model view, tap the Close button.

Name Surface 1 ADD

O Horizontal @ Vertical

Layer 0 e
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Measure Mode

Tap the Fence icon to edit the boundary of the surface. If you have existing points around the edges
of the surface, grab and drag the corner manipulators to the desired location to define the boundary
of the surface area. You can also define the surface by measuring new points.

To close out of the editing boundary, tap the Fence icon.

o
an &

Tap or measure vertical plane reference point (1 of 2)

Tap on Input Form . Enter Number of Points or Grid Spacing by tapping the Circle icon to
switch between options.

If you are using the Horizontal Surface, tap Ceiling or Floor.

Side
— START
() ceiling -

@ Fioor AUTOMATIC

For automated Laser data collect, select the Automation option.

Tap Start to capture data.
You are prompted to point the instrument at the surface to be measured, then tap Yes or No.

If collecting the Floor Surface manually, walk with the prism pole and navigate to the point to start
collecting data. If automatic, the instrument will use the laser mode to collect data and indicate
progress.

Calculate High & Low Areas

—_

> W

Tap on the Layout Flag icon E .
Tap thelnput Form g} icon.
Enter Elevation and Tolerance, and then close Input Form.

The High (shown in red), Low (shown in blue), and In-Tolerance (shown in green) contours are
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calculated and displayed on the screen.

Lay Out a Contour

1. Select a Node on the contour.
2. Ifin Laser Mode, tap Aim. The instrument points to the location with the laser pointer. If in Prism
Mode, you will receive navigation to the point.

3.  Tap Store to record the point.

©

@ A(E) Wi urtace 1, Surtion o 113 0 304

Layout Plane

The Layout Plane feature enables you to specify a flat plane, tilted plane, or sloping plane which can be used
similar to a rotating or sloping line laser. The Layout Plane feature also has audible sounds to help with
grading in loud environments to indicate high, low, or on-grade measurements.

Flat Plane

To define a flat plane, type in an elevation or pick a point on the screen. You can then lay out that flat plane.
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Measure Mode

Tap the Measure icon and then tap Layout Plane.
Either select a point on the screen or tap the Input Form and type in or measure an elevation.
Move to where you want to layout.

The software shows Cut (high), Fill (low) or In Tolerance (level). Points are recorded on the screen:
green for in tolerance, red for cut and blue for fill.

Tap the Shoot icon to collect as-built information and store this information for future use and
quality assurance.

v >
y @ O-

oft

Indicates Cut (High) Indicates Fill (Low) Indicates In Tolerance

Tilted Plane

To define a tilted plane, you can type select three points on the screen.

1.
2.
3.

Tap the Measure icon and then tap Layout Plane.
Tap the 3-Point Tilted Plane icon (] .

Either tap three points on the map screen or measure three points.

DI0 L o
- ©

0)

<] 2]

o

Tap Accept.

Move to where you want to lay out. The software shows cut, fill, and in tolerance.

Tap the Shoot icon to collect the as-built information and store this information for future use and
quality assurance.

To measure a new tilted plane, tap Configure and repeat steps above.
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Sloping Plane

To define a sloping plane, you can type select three points on the screen.

1.

2
3.
4

Tap Measure i and then tap Lay Out Plane.
Tap the Sloping Plane icon .
Either select a point on the map screen or measure a point.

Tap Input Form to enter: Direction of Slope and either Slope Percentage (%) or Rise/Run.

Divection 000,00 D 000 11,000

Move to where you want to lay out. The software shows cut, fill, and in tolerance.

Tap the Shoot icon to collect the as-built information and store this information for future use and
quality assurance.

To measure a new tilted plane, tap Configure and repeat steps above.

Traverse (Optional Module)

Use the optional Traverse module to check control points, add control points, or to establish benchmarks
around the project. The Traverse feature requires you set up on a known point and have at least one other
known control point. These points must be established as control points with the triangle symbol under the
Point Manager tool. This option is not available with the Rapid Positioning Tool (RPT).

There are two types of mathematically closed Traverse that are supported in FieldLink, Polygon and Link.

In the Polygon traverse, as shown in Figure (a), the lines return to the starting point, thus forming a closed
figure that is both geometrically and mathematically closed.

Link traverses finish upon another station that should have a positional accuracy equal to or greater than
that of the starting point. The link type (geometrically open, mathematically closed), is illustrated in Figure (b).
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c
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{al 1]
Lesgand
Contral point i Measured angle
Traverse station 4 Measured distance

To conduct a traverse:

1. Tap the Device icon i and then tap Traverse. A message will appear telling you to “Select and
position the instrument over a known control point”.

@ (® select and position the instrument over a known control point

2. Tap on the point for the desired instrument location.

3. A message will then appear telling you to “Configure the targets and select the backsight point”.

TN\ \
@ (® configure the targets and select the backsight point K)( ) 0
7

4.  Tapthe Input Form icon to enter the Backsight Prism Type, Rod Height, and select the
Backsight from the map view when done. Enter the Foresight Prism Type, Rod Height, Point
Name, Point Description and Layer (Create New or Enter Known Point).

Backsight Foresight °

Rod Height 4.333 ft I|' Rod Height3.479 ft

Name < Select from map > Name 105

Description Description °
(o OOV o) () 8V o) (7))
00/0/00/0/0/0/00100/010
¢ O / 5010 N
3/0/0/000000N0.0.010,
N { \

Ou@u@@@uuc o )
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5.  Toreturn to the map view, tap the Input Form icon again . Make sure the instrument location has
been selected, then aim at the backsight point and tap Measure.

6. Aim at the foresight location and tap Measure again.

The instrument will then go through a series of Face 1, Face 2 and/or backsight/foresight
measurements based upon the settings for rounds.

8.  Once the rounds measurements are complete, you can add a round to that set of measurements, or
store the point.

Rounds measurement complete

Custom Prism 1Custom Prism 1
@ MaxAHA: 0°01'512"  0°02'12.0"
MaxAVA: 0°00'57.6"  0°01'245"
Max ASD: 0ft

9.  Place the instrument over the foresight location, configure the targets using the Input Form, and
place the actual prisms over the new backsight and foresight location.

10.  Aim the instrument at the first location, which is now set to the backsight, and tap Measure.
11.  Aim the instrument at the new foresight location and tap Measure.

12.  Repeat this process for the remaining control points.

Traverse Calculations and Report

Calculation Definitions:
Adjustment

e Transit - In this adjustment method, it is assumed that directions are measured with higher
precision than distances.

e Compass/Bowditch - In this adjustment method, it is assumed that distances and directions are
measured with consistent precision.

Tolerance

e Horizontal Precision - Defines the lower limit for horizontal precision. Precision is the ratio of
traverse length to horizontal misclosure.

e Vertical Precision - Defines the lower limit for vertical precision. Precision is the ratio of traverse
length to vertical misclosure.

Error Distribution - Angular
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e Proportional to distance - adjustments are weighted more heavily for angles with shorter traverse
lines than angles with longer traverse lines.

e Equal proportions - angle adjustments are weighted equally regardless of the length of the traverse

lines.

* None - no angle adjustment is performed.

Error Distribution - Elevation

e Proportional to distance - adjustments are weighted more heavily for elevations with longer traverse
lines than elevations with shorter traverse lines.

e Equal proportions - elevation adjustments are weighted equally regardless of the length of the
traverse lines.

e None - no elevation adjustment is performed.

To Execute a Calculate and Save a Report
1. Tap on the Calculation icon {E] .

2. You can review the Traverse Result information.

Summary

Station information

Distance adjustments (four difference sets of data can be review)
Horizontal distances before adjustment

Horizontal adjustments

Vertical distances before adjustment

Vertical adjustment

3. Tap Accept and then tap Save, OR

1.
2.
3.

Tap the Input Form icon[gL})] .
Select the Adjustment Type (compass or transit).

Input the horizontal and vertical precision.

Select the angular and elevation distribution (proportional to Distance, Equal Proportions
or None)

Adjustment (.

TOLERANCE
Horizontal precision 1: 50000 Angular @

ERROR DISTRIBUTION

Vertical precision 1: 20000 Elevation

The Traverse results are automatically recalculated.
Tap Accept and then tap Save.

You will have the option to open the report in a browser page. From here you can right click
the report and save the .html report to a folder of your choosing. You can also right click and
print the report as a PDF to a folder of your choosing.
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Tap Device | L8 (0 connect to GNSS, total station, or scanning equipment, set up the instrument location,
and change instrument and target settings.

If you have purchased GNSS equipment, you can connect to Trimble R8s GNSS receivers and VRS or RTX
networks depending on your license type.

If you have a Trimble Tablet with a built-in radio or optional external radio, you can connect to various
Trimble Robotic Total Stations and the Trimble X7 or X9 3D Laser Scanner.

Connection

Before you can collect or lay out data, you must first connect a Robotic Total Station, Rapid Positioning Tool
or GNSS Receiver, make sure the prism and instrument settings are correct, and then set up the instrument
for its position on the project. The instrument and prism tasks are all accomplished in the Device Mode.
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Robotic Total Stations (RTS)

To connect to the instrument, make sure the RTS is turned on with a fully charged battery.

1.

w

Noo uoA

Tap the Device icon.
The connection window opens. Make sure to select the RTS icon from the row of instrument types.

Place the battery into the RTS with the battery indicator down and the charging ports facing the
inside of the RTS.

Press the power button on the RTS.
Enter the Channel and Network ID that matches those in the Face 2 display on the RTS.
Tap Connect.

Once completed with the layout or collection process, tap the Disconnect icon in the connection
window before turning off the RTS. Tapping the Disconnect icon helps ensure a proper shutdown
and later reconnection.

A e T

Channel 4

1130

Network 3
(a5

Bluetooth link ¢
between a data
collector and a
TOL2.4 data link
radio

Trimble Radio link
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NOTE - When connecting to an RTS using a Trimble Data Link Radio, the radio must be paired before
first use.

Pairing Instructions

While in the Connection window, after setting the correct Channel and ID, press and hold the “radio” button
on the Trimble Data Link radio before pressing the Connect button in the Connection window.

Once the Trimble Data Link Radio is successfully paired, the radio's Bluetooth name is shown in the FieldLink
workslate.

Press the "radio” button on the Trimble Data Link Radio for 2
seconds to enable discovery mode before pressing CONNECT

Radio: RB 001020 ( DISCONNECT )

Rapid Positioning System (RPS)

To connect to the instrument, make sure the RPT is turned on with a fully charged battery.
1.  Tap the Device icon.
2. The connection window opens. Make sure to select the RPT icon from the row of instrument types.

3. Place the battery into the RPT with the battery indicator up and the charging ports facing the inside
of the RPT.

4.,  Press the power button on the RPT.

Select the correct RPT serial number from the list of available instruments or press the Find button if
your device is not shown.

6. Tap Connect.

Once completed with the layout or collection process, tap the Disconnect icon in the Connection window
before turning off the RPT. Tapping the Disconnect icon helps ensure a proper shutdown and later
reconnection.

TIP - Make sure your tablet is disconnected from other WiFi sources to ensure a clear connection to the
instrument.
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Trimble Ri

Upon powering on the instrument, the Ri automatically performs a tilt detection and a field calibration. The
instrument rotates horizontally during tilt calibration. It is important to know that the instrument even if not
physically leveled. Instead the instrument calculates the tilt plane and during measurements applies a
correction based on the amount of tilt.

During field calibration, the instrument moves side-to-side and up and down. Field calibration focuses the
mirrors, calibrates the instrument to infinity, and adjusts the instrument to environmental conditions. Thanks
to the self-calibration of the instrument, it does not have to be sent in for service annually like other total
stations need to.

Avoid touching the instrument during its calibration process. The Ri is gear-driven and interfering with its
movements is not advised.

The full autostart process takes around three minutes. After the instrument is calibrated to its environment,
it can connect to a data controller. A connection cannot be made while the instrument is still in calibration
mode. Note that level detection and tilt compensation is performed during the calibration and connection
stage, so there is no need to auto-level again.

Once the instrument has performed the calibration, you can select the Vibration Sensitivity to be High, Low,
or Off. Vibration sensitivity does not actually detect vibrations, rather it measures changes in its
surroundings. High considers all environmental factors, and low considers all except for changes in
temperature and timeout. Setting it to Off is only appropriate for demonstrations in extreme conditions such
as set up on a meeting room table as this ignores all environmental factors, except for the instrument being
off level by more than 5 degrees.

To connect to the Ri
1. Select the correct Ri serial number from the list of available instruments or press the Find button if
your device is not shown.
2. Tap Connect.

Once completed with the layout or collection process, tap the Disconnect icon in the Connection
window before turning off the Ri. Tapping the Disconnect icon helps ensure a proper shutdown and
later reconnection.

To change the WiFi Band

—_

Tap Device E and then tap Settings.
Click on the Wi-Fi Band arrow.
Select Band Automatic, Automatic24GHzOnly or Automatic5GHzOnly.

> wonN

Reboot of Ri is required for the new Band to be in effect.
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Global Navigation Satellite System (GNSS)

1. Tapthe Device icon.

2. The connection window opens. Make sure to select the GNSS icon from the row of instrument types.

w

Place the battery into the GNSS receiver with the charging ports facing the inside of the GNSS
receiver mating charging ports.

Press the power button on the GNSS receiver.
Enter the Channel and Network ID that matches those in the Face 2 display on the RTS.

Tap Connect.

N vk

Once completed with the layout or collection process, tap the Disconnect icon in the Connection
window before turning off the RPT. Tapping the Disconnect icon helps ensure a proper shutdown
and later reconnection.

US-2013 - 12.5KHz US-2013 - 25.0KHz

LINK RATE (bps) 96007, 19200

TrimTalk450S

Satel Satel

Forward Error Forward Error

Correction (FEC) ON OFF Correction (FEC) ON OFF
Scrambling ON OFF ‘Scrambling ON OFF
LINK RATE (bps) 9600 LINK RATE (bps) 95007, 19200

Forward Error Forward Error

Correction (FEC) ON OFF Correction (FEC) ON OFF
Scrambling ON OFF Scrambling oN OFF

LINK RATE (bps) 9600 LINK RATE (bps) 96007, 19200

Forward Error Forward Error

Correction (FEC) ON OFF Correction (FEC) ON OFF

Scrambiing OoN OFF Scrambling OoN OFF

LINK RATE (bps) 4800 LINK RATE (bps) 4800

WARNING - Link rates marked with an asterisk (*) indicate a wireless mode that is illegal within the US
as of January 1, 2013 (https://www.fcc.gov/narrowbanding-overview)

Prism Settings

To take correct measurements, you must first select the correct prism type, prism height, and rotate the RTS
to the correct measurement point. To do this you must be connected to an instrument.

Prism Quick Access

The Prism Quick Access button ﬂ allows you to access the prism quickly from the main map screen.

1.  Tapthe Prism Quick Access button.

2. Select the desired target type from the Target Type selection list. Options include the 360 Prism,
MT1000, AT360, Reflective Foil (with the Ri instrument, autolock can be disabled if desired) or Custom
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Rod Height 0 ft f

The Custom Prism icon allows you to add, name, configure and save commonly used prisms
on your job site.

Tap the Custom Prism icon and populate the fields including prism name, prism
constant, and check the box if the prism is wider than 30 mm (1-3/16").

Prism Name Custom Prism 1 (1]}

Add New

Prism Constant

Prism Size > 30mm

Type in the correct height of rod (HR). Measure to the center of the prism to the tip of the rod for the
360, MT1000 and AT360 prisms. If you have an Inverted Layout Rod you can use the value
displayed on preset positions.

If you want to shoot the control points utilizing the EDM laser beam (also known as laser mode), tap
the Prism icon in the upper left to toggle between prism and laser mode.

Tap the Vision icon to turn on the live video camera within the RTS. In Trimble Vision mode, you can
tap on the video image to rotate the RTS to a specific point or use the Joystick icons as well. There are
zoom controls on the right side of the screen to zoom the video feed in or out.

Slide out the () and tap the Joystick icon to activate the horizontal (left hand side) and vertical (right
hand side) movement bars. Tap the Joystick icon again to close the tool.

Tap on the Search icon to lock onto a prism. The search mode closes Vision mode and opens the
plan view in order to lock onto the prism. The prism icon appears to be rotating if the RTS is not
locked onto a prism, and is solid once locked onto the prism.
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8. While locked onto a prism or aiming in laser mode, this screen provides the HA (Horizontal Angle), VA
(Vertical Angle), SD (Slope Distance), HD (Horizontal Distance), VD (Vertical Distance), X, Y and Z
coordinates.

Tap to Search

If you are not locked onto the prism, the prism icon in the upper left corner appears to be rotating and not a
solid icon. A question mark icon appears in the upper left corner next to the prism icon which you can tap to
start a localized search in an 11 degree tall by 15 degrees wide window for RTS series, 25 degrees tall and
wide for the RPT.

1. Ifthe prismis not locked, a line will appear where the instrument is pointed.

2. Tap on the screen roughly on the location of the prism. The instrument should automatically point to
the tapped location and start the search process for the selected prism.

3. Ifthe prism is not found automatically, tap in another location on the plan view or use Trimble Vision
to isolate the search area.

@ Trimble. Trimble Field Link =
=0
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Trimble Field Link
445

Pano-Search

By clicking on a panoramic Image generated by the field instrument, you can quickly lock onto the prism at
your location thus eliminating lengthy aiming of the instrument. The pano-image can also be used for quick
aiming in laser measurement mode.

1.  Tap Panoicon to collect panorama image (2-10 minutes).

2. If apanorama already exists on the tablet, you can use the stored one or take a new one. Only use
the stored one if the instrument has not been moved.

3. Panimage, then tap/double tap on image that you see behind RTS to initiate the search for a prism.
(Single tap for Windows 10 tablet or double tap for Windows 7 tablet).

4. Inlaser mode, tap on the image to aim to location.

“HIEP
q -d~—|

0os

Trimble Ri Vision and Joystick Controls

The table below describes the icons/controls available for the Trimble Ri .
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Icon

Description

Maximum Zoom Level
(Prism Mode)

Maximum Zoom Level
(Laser Mode)

Detail Zoom Level (Prism
Mode)

Detail Zoom Level (Laser
Mode)

Overview Zoom Level

Prism Search Lock

Laser AutoFocus

Target Search
(Horizontal)

Device Mode

Function

Targets may auto-lock if in view.

Precise aiming to natural target or feature.

Targets may auto-lock if in view.

Improved aiming to natural target or feature.

Prism Mode: Initial aiming, targets will not
lock automatically.

Laser Mode: Initial aiming to natural target or
feature.

This button appears in the VISION and
joystick screens. When pressed, the
instrument cycles through lens positions in
an attempt to lock onto a target.

This button appears in the VISION and
joystick screens. When pressed, the
instrument attempts to focus the laser and
sharpen the video image. This process
requires an adequate reflective surface.

Performs a side to side search for targets. It
does not adjust the focus distance of the
lenses. For that, use the Search Lock button
described above.
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Ri Camera Exposure Depending on how bright the environment is,
Settings select low, medium, standard or high
exposure settings for the camera.

Device Settings

Before taking any measurements, ensure the RTS is calculating the correct Reference Elevation, Temperature,
Pressure.

1.

2
3
4,
5

Tap the Device icon jf and then tap Settings.

FieldLink automatically opens the prism settings mode.

Tap the Device icon to modify the instrument settings and access other functions.

Tap the Input Form icon to type in the Reference Elevation, Temperature, Pressure.

The temperature should be input within 10 degrees Fahrenheit (5 degrees Celsius) to ensure the
accuracy of the electronic distance measurement.

The pressure should be input utilizing local weather reporting to ensure the accuracy of the
electronic distance measurement. The standard atmosphere is 29.92 inHg for imperial or 760 mmHg
for metric, but the barometric pressure will vary depending on weather conditions and altitude.

To change the WiFi band with the Ri:

1.

2.
3.
4.

Tap the Device icon i and then tap Settings.
Click on the Wi-Fi Band arrow.
Tap Band Automatic or Automatic24GHzOnly or Automatic5GHzOnly.

A reboot of Ri is required for the new band to be in effect.

To change the scanner settings and format SD card:

1.
2.

Tap the Device icon j&f and then tap Settings.
Tap the Format SD Card option.
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Measure Reference Elevation

Tap the Device icon j&f and then tap Reference Elevation.

—_

Tap Input Form [L )] to enter reference elevation.
Point instrument at the surface you wish to assign reference elevation.

Tap Measure. A message confirms the reference elevation has been measured.

AR

You also have options to clear or re-measure the reference elevation.

Turn To (Theodolite type option)

Use this feature to set the instrument angle to specific degrees/minutes/seconds, turn the instrument by a
set horizontal angle, or basic distance and angle measurements.

1.  Tapthe Device icon i and then tap Turn To.

2. Aimthe instrument towards the reference and tap Zero HA.

3. TapInput Form[g}] to enter a custom angle or use the preset angles of 90, 45 or 30 degrees.
4.  Tap the Rotate buttons to turn the instrument.
5

Measurement information is displayed to the new location such as Horizontal Angle, Vertical
Angle, Slope Distance, Horizontal Distance, Vertical Distance and Coordinate Values.
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30°

Custom

HA: 0° 00" 00" VA: 90° 07' 05"
SD: 30.304 ft N: -56'101/8"

HD: 303041t E: 12'113/16"
VD: -0.062ft Z: 133'311/16"

Tools

Device Mode

The Tools function has been added to quickly access measurement options using the instrument. These tools
can be used without completing an instrument set up or having any project information. Simply connect to

the instrument and then begin taking measurements.

Quick Vertical Alignment Check Tool

Tap the Device icon i and then Tools menu.

Select if you are working on a Column or Wall. You will see a message below giving instructions on
how to aim the instrument. Columns require one single point shot at the base, and you should be
perpendicular to the column. Walls require two points shot along the base to give an angle of
reference.

Use the Horizontal/Vertical Tools and the Bump Tools along the right hand side of the screen to
get the laser exactly pointed to the correct location(s), or tap the center of the screen to move the
laser directly.

Tap the Measure icon in the upper right corner, one location at the base of the column, or two
locations along the base of a wall.

Set the Tolerance distance at the base of the screen to the desired accuracy.
Aim the instrument at the top of the column or wall.

The screen will show the direction the column or wall should be placed for plumb and will go green
once the item is within tolerance.
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P
E| Aim laser to wall reference point (1 of 2) and press MEASURE (X )
J

Tolerance

6mm a)

[E] Aim taser at point to plumb and press MEASURE

{ REseT )

@ Column Tolerance
Lo ( emm  a)

Device Mode

TIP - The plumb tool within FieldLink offers you the ability to use the Vision tool. This uses the
devices camera to ensure this tool can be used in environments where the laser may be difficult

to see.

Aim laser to column reference point and press MEASURE - Instrument should be perpendicular
to column surface for most accurate results

@ column
O wall

Tape Measure Tool

1. Tapthe Device icon and then tap the Tools menu.

2. Tapthe Tape Measure icon.

Tap the Measure icon at the upper right corner when the prism is over the first point or aiming with

the laser.
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4, Tap the Measure icon at the upper right corner when the prism is over the second point or aiming
with the laser.

5. The Horizontal Distance, Vertical Distance and Slope Distance will automatically be displayed
after the second shot.

6. Ifyou have a station set up, the distances will also be given in an XYZ or NEZ format.

Benchmark Transfer Tool

1. Tapthe Device icon and then tap the Tools menu.
2. Tapthe Bullseye icon.

3. Tap the Measure icon at the upper right corner when the prism is over the benchmark point or
aiming with the laser.

4.  This position will be represented by a vertical tolerance bar displaying the collected benchmark
position at 0’ elevation.

AUTO ADJUST |

5. With the prism over the new elevation point to check for cut or fill. When aiming with the laser, move
the laser to the correct vertical position and click Auto Adjust to move the laser to the correct
elevation.

o

AUTO ADJUST |

Total Station Setup

This section covers setting up the total station before you start. Depending on your requirements, you can
set up the total station using one of the following methods:
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* SetUp - No Data, page 91

e SetUp - Unknown Location (Resection), page 92
e Set Up - Known Point, page 94

e SetUp - Panorama, page 96

e Set Up - Use Rounds (Optional Module), page 96
e SetUp - Grid Lines, page 97

e Component Based Set Up, page 98

e Retain Station Setup, page 100

Set Up - No Data

Device Mode

When you are starting a job with no reference data or points you can create your own arbitrary reference for
instrument setup. FieldLink offers two ways to do this, north facing setup and two points with elevation

setup.

North Facing Setup [ €3

1. Point the device in the desired direction.
2. Tap Set.

North Facing 2 Point Setup [§]"]

—_

Create a new job.

Tap the Device icon and then tap Setup.
Measure two points.

Use Input Form g )] to enter Elevation.

Select North and Base coordinates.

Use Rotation icons to orientate coordinates.
Tap Set.

e A T
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Set Up - Unknown Location (Resection)

The RTS can be placed in a convenient location as long as there are at least two control points with a known
location in the field of view. It is best practice to have the angle between the control points be within 45 and
135 degrees. The angle requirements help to ensure a more accurate calculation of the instrument position.
If two control points are not between 45 and 135 degrees, or for a more refined set up, measure 3 or more
control points and select the best measurements.

FieldLink uses a least square algorithm and computes the mean to determine station locations. The software
computes the mean error for both horizontal and vertical calculations and display the horizontal error in the
application. An unknown location (resection) requires a minimum of two measured locations preferably at 90
degrees to each other. Using more points improves the calculation. To get the best results, it is desirable that
each point used is equally spaced from each other around the total station at ranges that are greater or
equal to the furthest expected layout/collection point.

You can accept “unreliable” instrument setups if two control points within the 45 to 135 degree triangle are
not available. You can tap Set even with the unreliable set up, but be cautious about laying out new points
and be sure to check back to previously laid out points if possible. The best practice is to add a third or fourth
control point to the instrument set up to ensure accuracy and proper angular measurements.

Instrument posi

Set Up Instrument Anywhere |

arcs that are created by measuring Ref
Pt 1 and Ref Pt 2 and angle between

Acceptable Layout
Radius After Set Up

RefPt 2
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to layout distances

1 2

Tap the Device icon E and then tap the Set Up icon.

Tap on the first control point to be measured so it is highlighted with a blue circle. Make sure the rod
height and prism type are correct in the Prism Settings, and the RTS is locked onto the prism at the
correct point location (or pointed at the control point target directly in laser mode).

Tap the Shoot icon in the upper right corner.

Once the point has been measured, it is shown as a solid blue circle.

You can now uncheck the Include box for each measured point if you do not want the point
included in the Set Up calculations.

Tap on the second control point to be measured so it is highlighted with a blue circle. Make sure the
rod height and prism type are correct in the Prism Settings, and the RTS is locked onto the prism at
the correct point location (or pointed at the control point target directly in laser mode).

Tap the Shoot icon.

e Ifthe two points are within the 45 to 135 degree triangle, the Instrument Position Within
calculation shows a measurement.

e Ifthe two points are under 45 degrees or outside 135 degrees apart, the software labels the
set up as “unreliable”. You can tap the Set icon to accept this set up or measure another
point to add it to the calculations.

If necessary, tap on the third control point to be measured so it is highlighted with a blue circle.

Tap the Shoot icon. Repeat this process for additional control points as needed.
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10.  If you shoot more than 2 control points, you can tap on each measured point and uncheck the
Include box in the lower message bar and see how it affects the calculated position next to
Instrument Position Within dialogue box.

11.  You can reshoot each point at any time by tapping on the measured point and tapping the Shoot
icon.

12.  Tap Set once you are satisfied with the results. Alternatively, tap the Clear icon to clear all
measurements and start over.

~

Jo ' 000 -

Set Up - Unknown Location (Resection) - Angles Only

Angles Only Resection Setup is performed the exact same way as a traditional resection, except a
traditional resection takes into account the angles and distances from the instrument position to the control
points while an angles only setup ONLY takes into consideration the angles from the instrument to the
control points. This setup type is useful when you need to use control points with permanent prisms that
have been placed on a job site beforehand, and you may not know the type of prism or the prism constant to
input for the prism type.

Set Up - Known Point

On the jobsite, it may be convenient to set up the RTS on a known point to conduct the layout. Another
known reference point is required to complete the setup.

1. Tapthe Device icon and then tap Setup.

2. Tap Known Location icon.

3. Tap Instrument Location point on map then select & measure reference point.
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Known Point Setup - Ri Laser Plummet

You can use the Rilaser as a plummet for station setup.

1.

> wonN

Set up the Ri roughly above the point on which you would like the Ri to be located.
Tap the Device icon jif and then tap Setup.
Tap Known Location icon.

Tap the Plummet icon.
(0 @(»1m) e () @)

If the laser is +6” away from the desired point, gently move the tripod legs and instrument until the
laser is within 6" of the point.

Level the instrument by adjusting the tripod legs and tribrach adjustment screws.

Adjusting the level of the instrument, whether with the tripod legs or the tribrach adjustment screws,
moves the laser on the ground. If after leveling the instrument the laser is beyond 6" from the point
of interest, move the instrument again until the laser is within 6” and adjust the instrument level
again.

The laser will still not be above the point after leveling the instrument. To fine tune its position, slide
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Device Mode

the tribrach on the top plate of the tripod legs until the laser is above the desired point.

If this instrument goes out of level with this last step, redo steps 6 and 7.

Set Up - Panorama

By using the panorama picture taken with the RTS or RPT device you have the option to use the panorama to
select targets and have the instrument automatically measure the targets and assign them to execute a
station setup. Here are the steps to complete a panorama setup:

1.
2.

Tap the Device icon i and then tap Setup.
Tap the Panorama Setup icon .

If you have a panorama that you have just taken it is displayed on the screen, if you have a saved
panorama from the existing station tap Open and select the panorama or tap Take New to capture
a new panorama.

You are prompted to select at least 2 targets in the panorama. Scroll around the panorama and
select the targets.

Tap Start. The instrument automatically turns, locks onto and measures each target.

A toast message will appear stating "Unable to resolve instrument position" and asking you to select
a point on the map that the instrument is currently aiming at. Select a point on the map screen and
tap Assign. The instrument will then point to the next target, repeat the process for each target.

Select option to Store Instrument Location if desired.

Tap Set.

Set Up - Use Rounds (Optional Module)

If you have purchased the optional Site Control Module, you can choose the Use Rounds option for both the
Known and Unknown Location Set Up.

1.
2.
3.

Tap the Device icon i and then tap Setup.
Tap the Known or Unknown Setup icon.
Check the Use Rounds box.
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You will then be prompted to set the Face Order (F1/F2, F2/F1, or F1 only), the number of rounds
(shoot each point 1 - 10 times), and measure mode (high or fast precision).

Press the Shoot icon to start the rounds collection process.

7=

@ [E] setect instrument location then select and measure reference point (X ) m
N

= — Measured Distance ---

[ Use Rounds

= q

[ Y B s s oo s cin (O
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e\‘ g8 s Instrument Position Within: — e

]
5

M
1/

™ u:

[ ——— — Measure Mode —
Face Order Rounds @ High Precision

( rmsr2 A 2 a) O FastPrecision

Set Up - Grid Lines

NOTE - For absolute best accuracy setup, Trimble recommends using a standard resection instead of
grid line setup. Only use a grid line setup as a last resort.

1.
2.

5.

Tap the Device icon i and then tap Setup.
Tap the Grid Line Setup icon.

Select the firstline

Tap the first grid line.

Measure the first point on the selected grid line.

Measure the second point along the same grid line.
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6. Tap the second grid line.

Measure the first point along the grid line.
Measure the second point along the grid line.
Select the station to position the instrument.

10.  Ifthe Deviation is acceptable and then tap Set.

Control point 3: dX: 13/4" dY:0ft dZ:0ft
Control point 4: dX: 1/16" dY:0ft dZ:0ft

11.  Once Set is selected, a message indicates that a reference elevation is recommended for the setup.
Select the Reference Elevation button to aim the instrument to a feature, take a measurement and
input the elevation of choice to use as reference for the rest of the setup.

©

‘ | - [ERE—

Component Based Set Up

This feature enablea you to set up on an unlevelled surface to help with fabrication items and ensure
accuracy to the modeled item.

l NOTE - When using a scanner Trimble recommends using only one scan.

With the Component Based Set Up, a rigid transformation of the model is performed, requiring at least three
points. When there are more than three points, a least squares solution is obtained. The centroids of the map
data and the measurement data is calculated. This allows the software to calculate optimal rotation and
translation matrices that are used to find the setup location. Error is the square distance error between the
points in the two datasets.
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Tap the Device icon i and then tap Setup.
Tap the Component Based Set Up icon.

Select and measure at least 3 points on the component to set the new level for the component. Use
the Layer and/or Section Box Tools to isolate a specific component to use for set up and layout.

NOTE - Points do not need to be created before using the tool. You have the ability to create
necessary points on the model for use in their component based setup.

Once you measure at least 3 points, the position of the instrument and a residual setup error is
shown. Tap Set to complete the setup and start laying out additional component connection points.

To process the new component level, the software changes the laser to standard aim instead of
visual layout.

Residuals: —

Residuals: -
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Include Point Residuals: 1/4"

Retain Station Setup

If you have performed a station setup (total Station, GNSS or scanner setup), you can retain that setup and
the control points used for the setup when changing jobs within one project. This means you can navigate
efficiently between layout jobs in one project without having to re-setup the instrument.
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Reports Mode and Status Sharing

To create and view a daily layout summary, layout deviation, field report or report on surfaces collected, tap

More and then tap Reports.

To show the progress of the various model components, Tap More H and then tap Status Sharing.

The Status Sharing tool can push progress information to Trimble Connect Desktop or Tekla software with
the installation of the Status Sharing extensions from those applications.

The Trimble Connect Sync Tool helps you keep a local copy of all your critical project data right on your
computer or automatically upload it to the cloud for safe storage. Once connected, you can upload or
download FieldLink jobs, models, point files, and reports from your Trimble Connect project when you have
Wi-Fi service. You may also be able to use your cell phone to create a Wi-Fi hotspot while out in the field,
depending on available cellular signal.

Creating a Trimble Connect project is quick, easy and free for a personal project with up to 10GB of data
storage. Training documentation, help files and more information can be found at connect.trimble.com.

Layout Deviation Report

The Layout Deviation report allows you to create spreadsheet style layout data for the entire project,
including project information, point information, and delta values (in XYZ and NEZ), for points that were laid
out in the range of dates defined in a .csv format.

1. Taponthe More icon , tap Reports, and then tap Layout Deviation Report. A preview of the
report appears on the screen.

2. Tap on one of the column headers to sort by point name, description, layer, northing (Y), easting (X),
elevation (Z), or by deltas. Tap again to sort by ascending or descending order.
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3.

Tap on the Input Form

ayout Deviation Report
TRLTHME LEVELY b

Thursday, August 11, 2016 24457 PM
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The report default saved location is under the
C:\Users\xxxx\Documents\FieldLink\Reports\Layout Deviation Reports folder.

Reports Mode and Status Sharing

icon to designate where you want the report saved.

Tap on the Layer icon to save the report to your computer, a USB drive, or Trimble Connect. You will
need to disconnect from the RTS and sign into Trimble Connect for it to be an option. The USB option
is only available when a USB memory device is plugged into the computer.

Tap the Save icon.

Export DEslina:igllIia\Documents\Trimble Field Link\ReportsiLayout Deviation Repun%

I —
@ Device
# usB

frimttecomearroecs

& BPFL_Transfer

A B C | D E E G | H 1 J K
1 Trimble Field Link
2 Layout Deviation Report

3 TFL_TAMB_LEVEL3 b

4 Friday October30 2015
5 3:27:25PM
5
7
8
9

Point Name Description Layer Northing [Easting (X Elevation DeltaH  Delta N (¥ DeltaE (X, Delta V (2

10 1076 dooor 0-15.259m L725m 38893m 0.012m -0.012m -0.003m 0.097m
11 1081 dooor 0-8135m 2.032m 38392m 001lm 0.006m -0.009m -0.001m
12 1082 dooor 0-9458m 2.085m 38.985m 0.005m 0.000m -0.005m -0.001m
13 1083 dooor 0-10.786m 2.142m  38.980m 0.158m 0.145m 0.064m 0.105m
14 1084 dooor 0-12119m 1.621m  38.380m 0.001m 0.00lm 0.000m 0.011m
15 1085 dooer 0-13.608m 1.151m 38581m 0.002m 0.00im -0.002m -0.001m
15 1086 dooor 0-14984m 1.713m 38988m 0.010m 0.004m 0009m 0.000m
17 1087 dooor 0-16.056m 2.552m 38.9%9m 0.006m -0.002m -0.005m 0.000m
18 1088 dooor 0-16.559m 4571m 39.008m 0.005m -0.002m 0.005m 0.001m
19 1083 dooor 0-16589m 5914m 39.007m 0.008m -0.007m -0.004m 0.000m
20 1030 dooor 0-16.021m 8767m 39.004m 0.007m 0.007m -0.003m 0.001m
21 1091 dooor 0-14.554m 8.826m 35.000m 0.006m -0.004m -0.004m 0.000m
z 1092 dooor 0-13218m 8.850m 353%4m 0.005m -0.002m 0.005m 0.000m
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Daily Layout Summary

To create a Daily Layout Summary report:

1. Tapthe Moreﬂ icon, tap Reports and then tap Daily Layout Summary.
Select Date, Destination, and enter Notes.

Tap Preview.

H wonN

Selecting Preview opens up a browser page with the Field Report. Right-click the report to save the
.html report or to print the report as a PDF to a folder of your choosing.

Daily Layout Summary

[Fone Fapon Cromed
[T

| e
[Goams

Layout Session 1

Field Report

To create a Field Report:

1. Tapthe Morem icon, tap Reports, and then tap Field Report.

2. Enter Name, Destination, Notes, capture Pictures, and measure Location (pictures can be
collected via tablet of RTS).

Tap Preview.

4,  Selecting Preview opens up a browser page with the Field Report. Right-click the report to save the
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.html report or to print the report as a PDF to a folder of your choosing.
Trimble. Field Link

Field Report

Date Thursday, September 29, 2018
ime 12:23:15 PM
rimble Fiald Link Job ld2a

lighpole base

X:101.030 m ¥: 116.801 m Z: 0.722 m

Surface Report

To create a Surface Report:

1. Tapthe More icon, tap Reports, and then tap Surface Report.

Tap the Fence @ icon to select the surface.

w

Select surface by either tapping on the display or by entering the surface name in the bottom right of
the screen.

Tap the Fence icon to close selection.
Tap the Input Form icon .

Enter Report Name.

N o Uk

Tap Preview to open up a browser page with the report. Right-click the report to save the .html
report or to print the report as a PDF to a folder of your choosing.

8.  Check the CSV Export box to also export the collect points list.
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9. Tap Save.

Vertical Surface]

Surace Name: Surfoce 1 rt Point Location J—
Report Nam 2 1 Surface Report & { ( PREVIEW |

CsvExpORT

Trimble. Field Link

Sutce Repart

Thardey June 7, 015
B

Toral Foints

Near Points

ear Contonrs

rName: Surfce 1 Sufac

) surface 1_20180607_150233.csv - Notepad - o X
File Edit Format View Help

NAME,X( ft ),Y( ft ),Z( ft ),DESC,LAVER,ATTRIBUTEL NAME,ATTRIBUTEL VALUE ~
Surface 1_0,351.652,368.663,7.615,Not staked,@,SurfacePointTolStatus,In tolerance
Surface 1_1,351.617,368.168,7.526,Not staked,@,SurfacePointTolStatus,High

Surface 1_2,351.622,367.667,7.527,Not staked,@,SurfacePointTolStatus,In tolerance
Surface 1_3,351.614,367.169,7.527,Not staked,0,SurfacePointTolStatus,High

Surface 1_4,351.618,366.668,7.527,Not staked,@,SurfacePointTolStatus,In tolerance
Surface 1_5,351.613,366.170,7.527,Not staked,@,SurfacePointTolStatus,In tolerance
Surface 1_6,351.619,365.667,7.528,Not staked,@,SurfacePointTolStatus,In tolerance
Surface 1_7,351.615,365.168,7.528,Not staked,0,SurfacePointTolStatus,In tolerance
Surface 1_8,351.616,364.667,7.529,Not staked,@,SurfacePointTolStatus,In tolerance
Surface 1_9,351.612,364.168,7.528,Not staked,@,SurfacePointTolStatus,In tolerance
Surface 1_10,351.609,363.669,7.528,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_11,351.608,363.169,7.528,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_12,351.605,362.669,7.528,Not staked,0,SurfacePointTolStatus,In tolerance
Surface 1_13,351.617,362.162,7.530, Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_14,351.611,361.664,7.530,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_15,351.603,361.167,7.529,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_16,351.600,361.169,7.029, Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_17,351.607,361.666,7.029,Not staked,®,SurfacePointTolstatus,In tolerance
Surface 1_18,351.614,362.163,7.030, Not staked,0,SurfacePointTolStatus,In tolerance
Surface 1_19,351.605,362.669,7.029,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_20,351.613,363.166,7.029,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_21,351.610,363.668,7.029,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_22,351.609,364.170,7.028,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_23,351.621,364.665,7.029,Not staked,0,SurfacePointTolStatus,In tolerance
Surface 1_24,351.617,365.168,7.029,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_25,351.605,365.672,7.027,Not staked,@,SurfacePointTolStatus,High
Surface 1_26,351.615,366.169,7.028,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_27,351.619,366.668,7.028,Not staked,®,SurfacePointTolStatus,In tolerance
Surface 1_28,351.613,367.169,7.027,Not staked,@,SurfacePointTolstatus,High
Surface 1_29,351.625,367.667,7.028,Not staked,0,SurfacePointTolStatus,In tolerance
Surface 1_30,351.614,368.168,7.027,Not staked,@,SurfacePointTolStatus,High

Surface 1_31,-
Surface 1_32,351
Surface 1_33,351
Surface 1_34,351
Surface 1_35,351
Surface 1_36,351
Surface 1_37,351
Surface 1_38,351
Surface 1_39,351
Surface 1_40,351
Surface 1_41,351
Surface 1_42,351
Surface 143,351

905.512, - 905.512, - 905.512,Not staked, @, SurfacePointTolStatus,High
.628,368.666,6.529,Not staked, @, SurfacePointTolStatus,In tolerance
.616,368.168,6.528,Not staked, @, SurfacePointTolStatus,High
-614,367.669,6.528,Not staked, @, SurfacePointTolStatus,High
.621,367.167,6.529, Not staked,@,SurfacePointTolStatus,In tolerance
.616,366.669,6.528, Not staked,0,SurfacePointTolStatus,In tolerance
.611,366.170,6.528,Not staked, @, SurfacePointTolStatus,High
.610,365.670,6.528,Not staked, @, SurfacePointTolStatus,In tolerance
.618,365.167,6.529, Not staked,@,SurfacePointTolStatus,In tolerance
.615,364.668,6.529,Not staked,@,SurfacePointTolStatus,In tolerance
.605,364.171,6.528, Not staked,0,SurfacePointTolStatus,In tolerance
.607,363.670,6.529,Not staked, @, SurfacePointTolStatus,In tolerance
.611,363.167,6.529,Not staked, @, SurfacePointTolStatus,In tolerance
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Status Sharing (Trimble Connect or Tekla Structures)

You can use FieldLink to download and upload status of model components with Trimble Connect Desktop
and/or Tekla Structures.

To access the Trimble Status Sharing applications for Trimble Connect Desktop or Tekla Structures, you will
need to download the application from the Tekla Warehouse. If using the Status Tool with Trimble Connect
Desktop, you will need to have a Pro-license of Trimble Connect and/or have an active subscription to Tekla
Structures.

1.

Go to warehouse.tekla.com, search for Workflow Tools and select the optional download for
Workflow Tools for Trimble Connect Desktop and/or Workflow Tools for Tekla Structures.

Select the appropriate application and install the executable file with Trimble Connect Desktop or
Tekla Structures.

Once installed, the Status Sharing Tool for Tekla Structures can launch from within Tekla Structures.

Search

Open Trimble Connect Desktop, select the project and the appropriate models and then launch
the Status Sharing Application.

In the Status Sharing Application, click the drop down on the left side and select Create New
Status Action, give the status a name, select the status values to include, and tap Create.

Select the correct date in the lower center area, then select the model components in Trimble
Connect Desktop view, and finally select on the appropriate status for the components. Select a
new date before changing status for additional model components.

You can reset the entire model to the original status by pressing the Reset button, or change
individual components status with the Date and Status buttons.

Change the date in the upper left corner and press the play button to show the sequence of
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component status by date.

Bossecsanee wik /<m0 &>

Status Sharing (FieldLink)

You can use FieldLink to download and upload status of model components with Trimble Connect Desktop
and/or Tekla Structures.

To access the Trimble Status Sharing application for FieldLink, you will need to order the Project Management
Module through your BuildingPoint or Trimble representative.

1.

In FieldLink, tap Moren , and then tap the Status Sharing button. Make sure you have the correct
model imported from Trimble Connect or already open in FieldLink.

Press on the Cloud icon in the lower right corner to select the correct project from Trimble Connect.
Any previously created Status Action names are displayed below.

Once a Status Action has been selected, you will have options to Update, Add New, Edit, or
Deletethe Status Action. If no previous Status Action is available, you can create a New Status.

Press on the Cloud icon again to retrieve the status colorization that were already created in
previous status action.

Once the status colorizations have been downloaded or a new Status Action has been created, you
can then add or edit status colorizations and dates for individual model components.

Press the Sync button to make the FieldLink Status Actions available for viewing or editing in Trimble
Connect Desktop or Tekla Structures.
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If you have a Trimble Tablet with a built-in radio or optional external radio, you can connect to the Trimble X7
or X9 3D Laser Scanner.

Use the FieldLink Scan Module to combine point clouds with FieldLink projects, overlay on 3D models and
PDF files, register and refine scans, and view 3D scans immediately after scanning.

NOTE - Trimble recommends limiting the number of visible scans on any one project to 50 scans. The
number of visible scans can be changed using the station manager and pressing the eye button @ for
individual or groups of scans.

Connect to the X7/X9 Scanner

FieldLink allows you to connect to several different types of instruments. Make sure you are connected to the
X7/X9 by executing the following procedure:

1.
2.

o vk W

Tap the Device icon and then tap Connection. The connection window opens.

Place the battery into the X7/X9 with the battery indicator up and the charging ports facing the inside
of the X7/X9.

Press the power button on the X7/X9.
Wait until the lights flash green, and then tap the X7/X9 device icon E in the Connection menu.
Select the Wi-Fi or cable connection option.

If the Wi-Fi option is selected, a list of available X7/X9 Wi-Fi networks available is shown. Make sure
you have disconnected from any other Wi-Fi networks. Tap on the correct X7/X9 device (eg: TRIMBLE-
X7/X9-XXXXX). If you do not see your device listed, tap the Find button.

Tap Connect on the correct device.

Once the layout or collection process is complete and you wish to disconnect from the instrument,
tap the Disconnect icon in the Connection window before turning off the X7/X9. Tapping the
Disconnect icon helps ensure a proper shutdown and later reconnection.

Remove the X7/X9 battery. Though it is not required, it is best practice to store the X7/X9 with the
battery out of the instrument for storage and shipping.
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Establish X7/X9 Device Location

Before taking any laser scans, you can shoot two known points (resection) from the PDF, plan, or model to
place the X7/X9 scanner at the correct location on the project. If you do not have a PDF, plan, or model, you
can also orient the instrument to its true north direction, an arbitrary plan north towards the top of the

screen, or gridline setup.

Plan North Set Up
' NOTE - To do a Plan North set up you must not have a model or PDF loaded into your project.

To perform a Plan North set up:

1. Tapthe Device icon i and then tap Set Up. If this is your first set up, the instrument rotates to
automatically calibrate itself for level measurements.

2. Select the Aim Instrument North{ j icon on the bottom left hand side of the screen. The visible
laser turns on and levels out at 90 degrees. Use the joysticks to aim the X7/X9 in the North direction
(either plan north or the actual direction north).

3. Use the joysticks to aim the X7/X9 in the North direction (either Plan North or the actual direction
North).

4.  Once the instrument is pointing in the right direction, tap Set. You will now be able to see which
direction the laser is pointed and now when you collect scans, the instrument knows its location
based on the direction it was facing during set up.

No Data Set Up

The second form of set-up without any data, uses a North and a base control point for set up. You may want
to use this setup method to create control points on a new project that you can tie into later.

To complete the No Data Set Up:

1. Tapthe Device icon 4 and then tap Set Up. If this is your first set up, the instrument rotates
automatically to calibrate itself for level measurements.

2. Tapthe North and Base Coordinate set up icon .
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Ensure that the X7/X9's laser pointer is on and use the joystick to point the laser to your desired
North and base targets (be sure to use the 45 to 135-degree triangle rule for these targets). If the

instrument laser pointer is not on, tap the Laser icon at the top of the left hand side of the
screen.

Tap the Shoot icon in the upper right corner of the screen to capture each point.

Tap on the points you have collected and choose which will be the North and which is the Base. A
blue circle appears around the point when the point has been selected. You can rotate the screen to
place the points orientated for plan North similar to Quick Vertical Alignment Check Tool, page 88.

Tap the Set button. Both coordinates are shown in the Map view.

Background Plan or Model Set Up (Resection)

1.

Tap the Device icon and select Set Up. If this is your first set up, the instrument rotates to
automatically calibrate itself for level measurements.

If you have a PDF plan, model, or drawing, tap the first control point to be measured so it is
highlighted with a blue circle on the screen.

Rotate the laser pointer on the X7/X9 to point at the correct control point location using the joystick
control screen.
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Tap the Shoot icon in the upper right corner. Once the point has been measured, it appears as a
solid blue circle on the screen.

Tap the second control point to be measured so it is highlighted with a blue circle on the screen.
Rotate the laser pointer on the X7/X9 to point at the correct second control point location using the
joystick control screen.

Tap the Shoot icon in the upper right corner. If the two points are:

e Within the 45 to 135-degree triangle, the Instrument Position Within calculation shows a
measurement of accuracy for placement within your project.

e Under 45 degrees or outside 135 degrees apart, the software labels the set up as
“unreliable”. You can tap the Set icon to accept this setup or recheck and re-measure the
control points.

You can reshoot each point at any time by tapping on the measured point and tapping the Shoot
icon.

Tap Set once you are satisfied with the location results. To clear all measurements and start over,
tap the Clear icon in the lower left corner.

Component Based Set Up

See Component Based Set Up, page 98.

Gridline Setup

See Set Up - Grid Lines, page 97

X7/X9 Scan Settings

Before taking any laser scans, ensure the scanner is using the correct settings for the type of scan you wish to
capture. You have the option to choose how many points you want to collect, if you want to collect photos,
and if the points need to be colorized or not. You may not want to collect photos or have the scans colorized
automatically as this slows the scanning and processing time. You can collect panoramas and complete the
process of colorizing the scans at a later time once complete with the project or at the end of the day.
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X7 Scan Settings

—_

Tap the Scan g icon.
Select Collect.

Tap the Scanner Settings icon in the lower portion of the screen.

A W

You can change the scan density, sensitivity, image capture settings, turn off auto-level and set the
lighting options using each drop-down next to each option. You can also view how each option will
affect the scan time, number of points captured, and the point cloud spacing with the display on the
right side of the screen.

Scan Settings Estimates

- 02:34 minutes
Density Low -
12 million points
High Sensitivi
[ High Sensitivity Point Spacing
mage Fast a 74" @ 16ft
19/16" @ 115ft

5. Tap the Scanner Settings icon again to close the screen and return to the Collect screen.

To begin the scan process, tap the Start button . You can also quickly press the power button on the scanner
to start the scan process as well.

e Ablue message bar shows that a pre-scan calibration has begun. You can cancel if needed.

* A message shows the percentage complete. This message also gives you the option to pause or
cancel the scan.

e Ifyou have not already established the X7 location, you are given the option to manually place the
scan once it is complete and loaded onto the tablet.

Fast Capture Mode

Fast Capture Mode allows you to capture scans without having the X7/X9 instrument self calibrate every
time. This saves an average of 60 seconds per scan. To initiate this setting:

1. Tap Scan and then tap Collect.
2. Tap Scan Settings.

3. InScan Settings, select Low in the density field and select the Low Range Fast Capture option.
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NOTE - There are many caveats to using this mode, including:

e Therangeis no longer 80 meters but limited to 30 meters

*  You must have the latest firmware version on the X7/X9 for this mode to properly function
(reference the release notes for the latest version of FieldLink for firmware version required)

e The scanner must run a calibration routine every 60 minutes. It will do this automatically.

e Iftheinstrument detects a temperature change of greater than 15°C it will run a full calibration
routine

e The accuracy of registration may deteriorate the further you get from the leveled and calibrated
scan so please adapt your scanning methods to accommodate for this.

e This mode disables touch to turn functionality inside of X7/X9 vision

AN Est 01:10
("] Free: 27.8 GB

X9 Scan Settings

—_

H W

5.
6.

Tap the Scan & icon.
Select Collect.
Tap the Scanner Settings icon in the lower portion of the screen.

You can change the scan density, speed (standard = 500k pts/s, high = 1M pts/s), sensitivity, image
capture settings and set the lighting options using each drop-down next to each option. You can also
view how each option will affect the scan time, number of points captured, and the point cloud
spacing with the display on the right side of the screen.

Scan Settings

01:27

Speed High a
P 8 27 million points

Image off A 38mm@ sm
37.7mm @ 50m
90.5mm @ 120m

Lighting a

Tap the Scanner Settings icon again to close the screen and return to the Collect screen.

Tap the Start button to begin the scan process. You can also quickly press the power button on the
scanner to start the scan process as well.

e Ablue message bar shows that a pre-scan calibration has begun. You will have the option to
cancel. For more information on the need to run a calibration routine see Atmospheric
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Corrections - X9, page 116.

e A message shows the percentage complete. This message also gives you the option to pause
or cancel the scan.

7. Ifyou have not already established the X9 location, you can manually place the scan once it is
complete and loaded onto the tablet.

Atmospheric Corrections - X9

The X9 laser scanner is a powerful instrument with the ability to capture 1 million points per second, an
extended range of 150 meters and an angular accuracy of 16”. Atmospheric corrections settings allow the
software to account for atmospheric effects of the captured points in a point cloud ensuring that point clouds
are as accurate as possible. These settings are particularly useful when using the maximum range of the X9.
The X9 automatically adjusts these corrections over time so manual inputs are not necessary. However, if you
choose to manually change these settings based on the capture environment, you can access these settings
by tapping Device i and then tapping Settings.

<

74
.
-

Temperature 72.0 °F

Auto Calibration and Self-Leveling

Both the X7 and X9 have built-in self leveling and auto calibration capabilities.

X7: At the start of each scan the X7 runs a calibration routine and then will automatically self-level adjust (the
instrument itself won't move as this change is all internally). The instrument lights will flash blue indicating
that it is working on these routines. The X7 will then begin slowly rotating which means it is scanning. The
lights will then turn white (only if images are turned on) and this means that the X7 is taking photos. Once the
instrument lights turn green, only then can you move the instrument.

X9: At the start of the first few scans the X9 runs a calibration routine and then will automatically self-level
adjust. Once the X9 reaches its optimal internal operating temperature, it no longer runs the calibration
routine. Typically the X9 reaches its optimum internal operating temperature after several scans (it may need
3 orit may need 7 - it really depends on the environment). After that the X9 runs a calibration routine every
30 minutes or when the internal temperature changes by 2°. This features saves up to 30 seconds per scan
as this routine typically takes around that time to properly calibrate.

The X7/X9 has lights on the side of the instrument. When the instrument is on and is being moved into
position, you may see the lights changing colors rapidly between blue, red, and green. The X7/X9 (when not
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scanning) have these lights flashing to show if the instrument is level or not and even shows which side of the
instrument is high or low.

The diagram below explains these lights and what the difference colors indicate:

A B
(.
; R f’f

. % '3
- ‘.
U_ B

{-&
I
!

E

Fig A: All five LED's are green, the instrument is properly leveled.

Fig B: Three LED's are flashing, the instrument is not leveled.
*  Green flashing = tripod leg near the LED does not need adjusting.
e Blue flashing = tripod leg near the LED is too low.
* Red flashing = tripod leg near the LED is too high.

Camera Settings

When selecting camera settings to capture images while scanning, the dropdown menu provides several
options depending on your environment. While Automatic is recommended for most situations, if you are
exposed to direct sunlight and notice the instrument is in a direct stream of light, switching to Daylight may
assist the instrument in correcting the image settings to the situation.

Daylight

Scan Se

Density Cloudy

[ High se Fluorescent

Image Incandescent

If the environment is too dark, an error message may appear indicating that image collection may take longer
than usual due to the instrument being in a dark environment.

High Quality vs Fast: selecting High Quality image capture will cause the collection process to be longer
because the instrument will be taking more photos than during the Fast capture process.

HDR: Allows the instrument to collect HDR (high dynamic range) images which will assist in bringing out the
highlights and contrasts in the photo. This process increases the amount of time it takes to capture images.
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Auto Zero Floor Elevation

When you collect a first scan or an unregistered scan, you can default to the extracted scanned floor as zero
elevation. This means that any point clouds above the floor have positive elevation and any points below the
floor have negative elevations. If you are unhappy with the extracted floor elevation, you can select another

point anywhere on the point cloud and define this point as the zero elevation. Therefore, the elevation heat

map and inspection reports will reference the elevation point defined in the steps above.

If you decide not to use the extracted floor as zero elevation, then the instrument will be the zero elevation
and any point clouds above the scanners have positive elevation and point clouds below the scanner have
negative elevation.

Station Numbering

When collecting scans, you can set scan station numbers at the start of the collection and the number for the
scan will auto increment going forward.

Once an instrument is connected, you can navigate to the Collect tab for scanning and select the Edit tab.

S\ R st 010 - \ — (@)
(o) & (st ) regsero (@umi a) L)

(9 Free: 206768 =
Elev: 0.000 m

Within the edit menu, you can set a scan station. Now the scan station can only be numeric from 1-1000 and
will automatically increment upward with each scan.

Station Name 6
(1-0999)

Layer 0 e

Scanner Elevation 0.000 m

Applies to last collected scan

(o) (.)
\_/ _

) B Est on10
OF; - CHED
¥2) 3 rree: 206768

Elev: 0.000m

For greater organization, every scan job can start at a new scan station number. Within the same scan job,
you can increase or decrease the scan station number using the edit form. Once the number is changed
within the same scan job, all scans collected after the change will begin incrementing upward from the newly
changed value.

' TIP - To avoid confusion, ensure the scan station numbers are not overlapping while incrementing.
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Viewing Scans in FieldLink

After scanning an area, you can view the scan three different ways - plan view, station view and perspective
view. Each of these views offers unique features that can help you access information immediately.

Viewing Options Ribbon

The ribbon on the bottom left of the screen holds several different options for viewing scan data. This
includes station color options, point size, station markers and numbers, and cloud view options.

0000)

Scan Data Colors

Station Color @) shows each scan station as a different color. The colors are automatically assigned during
the scanning process.

Intensity6 shows the reflectivity of the surfaces or objects in the scan. Blue and darker areas on a scan
mean the area is more reflective from the scanner perspective. Red means the area had more absorptive
surfaces from the scanner perspective. Highly absorptive or reflective surfaces may cause loss of point data
or less dense scans.

Grayscale © shows the scans in grayscale. Grayscale is useful to view data even if there is no ambient light
available during the scanning process.

Truecolor @ shows the scan as it's true color. The software overlays the colorized photos from the
instrument and matches it point by point with the data to show the point cloud in its real colors. This option
is only available if you have colorized the scans.
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Elevation @ shows elevation lines to represent where each part of the scan is along the Z-axis. You can use
these to align scans that are not registering along the Z-axis.

Registered Groups O shows each registered group as a different color. You can group scans by different
areas, floors, or regions for easier registration, viewing, or exporting.

Changing Scan Elevation Settings

When selecting the “Elevation” color option, you can set the distance between color repetition or choose to
turn off the repeating color pattern in order to customize the elevation data. To do this:

1. Open the Viewing Options Ribbon and select the colors icon until it cycles to Elevation view. The
elevation settings icon appears in the ribbon.

2. Tapon the Elevation Settings é icon.

3. Apurple crosshair appears on screen. This is setting the lowest elevation mark for the customizable
elevation bar. This is by default at 0. To edit the lowest elevation mark, you must tap on the
crosshair. A message saying “Please pick the starting point” appears.

4.  Once a lowest point has been established, select an endpoint by tapping on the screen.

' NOTE - If you want to lock the Z axis, select the Z axis lock icon in the bottom left corner

5. Ifyou do not want the elevation colors to repeat, you can uncheck the Repeat checkbox.

6. The editicon in the center of the bottom toolbar allows you to manually enter elevations.

Point Size

You can select from three different point sizes @ @@ .1 pixel is the smallest point while 3 pixels is a larger
point.

Station Markers

You can turn on and turn off the station markers and numbers to better view the scan data.
Station Markers OFF @

Station Markers ON® . The color of the triangle relates to the automatically assigned scan color.
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Station Markers and Station Numbers ON ©®

Point Cloud View Options

The default option on a point cloud is to have all the points visible so that you can navigate in and around
those points. There are three options under this icon.

Full Cloud @ is the default option that allows you to see the point cloud in its entirety.

Look Inside ® allows you to remove the data from the ceiling/roof/walls in order to see a floor plan view of
scan data without having to create a section box or go to the station view.

Outline ® only shows the outline of walls, structural steel, pipe, or other features, allowing for easy
visualization of the floor plan and edges.

Plan View

Plan view allows you to see a top-down view of the scan.

1.  Tapthe Moreicon | .
2. Select Map.

3. Torecenter scans on the screen, press the four-arrow icon in the top right ribbon.

(00000

4.  This ribbon also contains multiple views including plan view, two elevation views (front and right),
isometric view, and the plan view, or switch between parallel and perspective views.

5. You can also use the Orbit@) button to navigate freely through the data in 3D.

Station View

Station View allows you to view the point cloud or images from the X7/X9 perspective. This view includes an
almost 365° panoramic view of the area around the instrument. You can also access the perspective and
panorama views from the Station View.

1. Select the station view window located at the bottom left of the Map. By default it shows Station 1 in
Group 1.

2. Onceinside of the station view, there are two dropdown menus - one to select the group and one to
select the station number inside of that group. You can also cycle through stations using the arrow
icons.
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3. You can now use the View Options Ribbon to change the color of the scan. You can cycle between
four options - grayscale, true color, unmeasured points, and scan intensity.

Using Station View to Control Laser Pointer

In the Trimble X7/X9 firmware version R2.1.4 and later, the built-in laser pointer on the Trimble X7/X9 can be
controlled by tapping on the screen inside of a station view format. To control the laser pointer by tapping on
the screen:

1. Collect a scan with the Trimble X7/X9 by tapping Scan and then tapping Collect.

WARNING - Once the scan is complete, do not move the scanner. If you move the scanner then
the camera icon will not appear.

2. Tap Measure i in the top menu.
Tap either Lay Out or Collect.

4.  The Trimble X7/X9 automatically levels itself and a message appears saying “Setup has not been
completed”. You can set up the instrument on two known points at this time but it is not required to
use the station view as a controller for the laser pointer.

5. Once this is complete, the Camera icon @ appears. Tap the Cameraicon.

6. The software opens station view. A message appears along the bottom of the screen advising you to
“Tap anywhere in the scan to point the laser”.

Once you tap on the screen, the laser pointer on the Trimble X7/X9 moves and points to that spot.

8. Toincrease accuracy, zoom in on the screen or walk to where you would like the laser pointer to
appear and use the Dynamic Joystick @ to nudge the laser into place.

Tap and Search for Targets in Station View

After scanning an area with targets placed around the site, FieldLink can search and automatically identify
targets by using the “Search for Target” feature. To search and automatically identify targets:

1. Open Station View.

2. Tap atargetin view then select the check box titled Search Target. If a target cannot be found, try
using a different station view to search for the target.
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3. Usethe editicon to edit the marker name and description.
4.  Perform this step for all the targets in view of the scan.

5. Once these points are selected, then you can perform a regular resection or measurement.

Area Scan in Station View

After an initial scan has been completed, you have the option to perform an Area Scan inside of Station
View. Area Scan allows you to select a window or area inside of a Station View and perform a scan of only the

selected area. This is useful for easily exporting scans if you wants to export/analyze only a small section of a
scan and not the entire scan.

Once a scan is completed, the Area Scan icon populates the Collect workscreen. After the Area Scan option
is selected, the Station View is shown where you can select the area for the Area Scan.

N Esc 0135

( start ) Registerto
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Perspective View

r

You can find Perspective VieW and Panorama View\‘ on the left side of the screen inside of Station
View. In Perspective View, you are still viewing from the instrument perspective but now you can see the
point clouds and any background PDF files, plans, or models loaded into the project.

1. Inside of Station View, select the Perspective Icon.
2. Onthe bottom of the screen, you can navigate between stations and groups.

3. TheZoom SIider on the right side of the screen can assist in zooming in on the point clouds. You
can also use pinch to zoom.

4.  Perspective View also has the Viewing Options Ribbon to change the appearance of the point
cloud. See Viewing Options Ribbon, page 119 for more information.

5. To exit Perspective View, either select the Perspective View icon again or select the map on the
bottom left corner.

Viewing Panorama Images

Once you have generated a panoramic image (to learn how to create panoramic images see Creating
Panorama, page 126), to view them :

1. Open Perspective View .
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hand corner.

5. By tapping on this icon, you can cycle through HD panoramas and preview or SD panoramas. Also,
by opening this ribbon, you can also toggle the station markers on or off.

NOTE - To learn the difference between a High Quality and Preview panorama, seeDifferences between
High Quality Panorama and Preview Panorama, page 126.

To access these images, make sure to Save As your project after creating panoramas and open File Explorer
where they are located under This PC > Documents > Trimble FieldLink > Jobs > Job Name.dat > Scans >
Images > HighResolution.

Station Manager

Station Manager @ allows you to hide and unhide scans, colorize scans, create panoramic images, check
to see what station each scan is registered too, check the size of each point cloud, delete scans, and select
and highlight individual or groups of scans.
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Select/Deselect All
Panorama and Colorization
Layer Assignment o

Delete Scan )

Hide/Unhide All ©

Colorizing a Scan

To colorize a scan:

1. Tap either the group or individual scan you would like to colorize.

PGSRV L VETLL TR A RRRR R S

0 O

2. Tapthe Panorama and Colorization icon .

3. When the settings menu opens you can now use either the Colorize Point Cloud, the Generate
Preview Panorama or the Generate High Quality Panorama tools. In this case, select Colorize
Point Cloud.

~

i . @ 0 O

[ cenerate preview Pancrama

l Generate High Quality Panorama

L]
Al 3 = v @@ o

4.  Once you tap on that, the Art Palette icon begins to spin. This means the software is working on
colorizing this point cloud in the background. You can check the status of this process by tapping on
the notification bell in the top left corner.

o . Create Panorama x

Panorama
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Creating Panorama

To create a panorama:

1. Tap either the group or individual scan you would like to generate a panoramic image for.

R CAATLLGL AR TEL FRRRRSR B USRS Y

2. Taponthe Panorama and Colorization icon .

3. When the settings menu opens you can now use either the Colorize Point Cloud, the Generate
Preview Panorama or the Generate High Quality Panorama tools. In this case, select Generate
Preview Panorama (see Differences between High Quality Panorama and Preview Panorama, page
126 to learn about the differences between these methods).

[ Generate preview Panorama

N Generate High Quality Pancrama

L1
Ak 3 e v @ o

4.  Onceyou tap on that, the Art Palette icon begins to spin. This means the software is working on
colorizing this point cloud in the background. You can check the status of this process by tapping on
the notification bell in the top left corner.

o .Create Panorama x

Panorama

Differences between High Quality Panorama and Preview Panorama

The differences between a “High Quality” generated panorama and a “Preview” panorama is that the High
Quality image that is generated smoothes out the stitched edges between each of the images in the
panorama and creates a seamless image. However, in doing so, it diminishes the visibility of items in each of
the photos. So, for example, if you had text in one of the pieces of the panorama, it would become a bit
blurry and hard to read. The “Preview” panorama looks more cut together and blocky because it keeps the
full resolution of each individual image in the final stitched panorama. This allows you to zoom in on a part of
the image and be able to interpret items that are shown in the image such as text. See examples below:
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Assigning Scans to Layers

When you have a model in a FieldLink job, along with several scans, annotations, markers, layout points, etc.
it can become difficult to navigate around the project. Assigning a scan to a layer inside the model once
everything has been aligned can greatly assist you in the process of hiding and isolating areas where you
want to focus your attention. To assign a scan to a layer:

1.

> wonN

5.
6.

Open Station Manager @
Tap the station/scan you would like to assign to a layer.
Tap the Layer Assignment icon o

The Layer Assignment menu appears and you can either create a new layer or open the layers panel
to assign it to an existing layer.

Layer 0

N N SN
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To assign to an existing layer click on the Menu © icon to the right of the text box.

Select which layer you want to assign the scan to and then tap on the Apply Edits button to close the
menu.
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Layer A-DOOR

7. Now when you open the Station Manager you will see next to the station number that the scan has
been assigned to a layer. When you manipulate this layer through the settings menu, this scan will be
affected as well.
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Extract Detail/Density from Region Within Scans

When viewing point clouds in FieldLink, only a percentage of the points in the point cloud are displayed. To
view all of the points in a desired area of the scan, you will need to extract the extra points:

1. Tap on the information ribbon and select the Section View icon. If the model has many independent
sections, you can shrink the section view with the arrows to encompass the only section of interest. If
the model is a 3D model, you can select the 3D icon in the top right to be able to shrink the model in
the 3 axis if desired.

2. Inthe section view, select the + sign to create a new section view. You can select the pencil icon to
rename the new section view and give it dimensions if desired.

3. Once the new section view is created, select the cloud icon next to the section view you would like to
increase the point density on.

4.  Once FieldLink has processed the extra points, you can toggle this dense section on and off by
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tapping on the cloud icon again.

®  Bryce Antinoro s presenting

Create TFL Points from Scanned Data

In most cases, a field point is required in a project in order to layout a point using an instrument. Creating a
field point can also help when measuring between a model and point cloud. To create a point from scan data:

1. Tapthe Infoicon 0 in the bottom right corner .
2. Tap apoint on the point cloud. A circle appears around where you selected.

3. Tap the Create Point button under the Info button.

FieldLink Office

Turn Instrument Laser to Selected Scanned Point

You can turn the instrument laser to a selected scanned point from the Info icon. To do this:

1. Tapthelnfoicon 0 in the bottom right corner .
2. Tap apoint on the point cloud. A circle appears around where you selected.

3.  Tap the Turn to Point icon under the Info icon.
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Measuring & Calculations

When viewing the point cloud on the map and inside Station View, you can measure between points in the
point cloud. You can also measure between the model and the point cloud using Create > From Model (see
From Model, page 50) and creating points on the model that the measure tool can reference from the point

cloud.
1. Once in Station View, select the Measure/Calculation icon @.

2. You can lock the measuring tool either to the XY-axis, Z-axis, or leave it unrestricted. The following
bar appears:

This is an example if you are using the Z-axis lock. Once you select a point on the ground or ceiling, the
software automatically follows the z-axis on your next click. The measuring tool measures parallel distances
between walls on an XY-axis lock.

Screen Capture/Screenshot

To save the calculations you have made on the screen, use the Screen Capture feature to save a screenshot
of the current view in the station view directly on your device.

To take a screenshot:

1.  Go to station view by selecting More > Map and tapping the bottom left-hand corner. This also
works in plan view after selecting More > Map.

2. Select the Calculation tool @ in the upper left corner.

Once you have completed your measurements, a camera icon appears in the bottom right corner of
the screen. Make sure you have everything you want to capture is in your current viewing window
because that is what will be saved once you tap on this icon.
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4. Tap the Camera icon. The confirmation message appears:

V Save Image successful

5. By defaultimages are saved to This PC > Documents > Trimble FieldLink > Images in a folder with
the current project name. To change this file location, tap the Edit icon ﬂ next to the Camera icon
and then tap the Folder icon and use the File Explorer to select the folder to save screenshots to.

Annotations & Markers

When scanning complicated projects, it may be difficult to identify objects of importance or of interest. By
adding an annotation or marker, this can call attention to things that need to be fixed, changed, replaced, or
generally highlighted.

Adding an Annotation

1. Tap More > Map and then tap Station View in the bottom left corner.
2. Tap the Calculation icon@ .

3. The marker and annotation icons appear next to the XY and Z lock measurement icons on the
bottom left corner of the screen.

4.  Tap the Annotation icon .

Once the annotation menu appears, you can enter text using the built-in keyboard and then tap the
Annotation icon that is highlighted yellow to close this menu.
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Text Example ‘
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6.  Now you can tap where you would like the annotation to appear.

A Tap a location to place the text

7. To move the annotation to another location, click the pink arrows and drag to where you would like
to relocate the text.

8.  Tochange the text, tap the Edit Text icon .

9. Todelete an annotation, tap the annotation you would like to delete and select the Delete icon o
in the bottom right corner .

Adding a Marker

1. Open Station View.

2. Tap onthe Marker icon u The marker icon shows a small triangle with a number next to it. This
represents which station view you are in.

3.  Tap where you would like to place the marker. You can move the marker to another position using
the pink arrows next to the marker.

To edit the marker, tap the Edit Marker icon ﬂ

Once in the edit menu, you have the option to change the name of the marker, the marker
description and the marker color.
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To attach a photo to the marker, tap the Camera icon G to open the device camera to capture a
photo or tap on the File icon ) to upload an existing photo from your device.

Once your edits are complete, tap the yellow edit marker icon to exit the edit menu.

To delete a marker, tap the marker you would like to delete and tap the Delete o button in the
bottom right corner.

Another feature of the markers is the ability to save a view based on the markers you add. To do this:

1.

After creating a marker, the Save View icon appears. Tap this icon. A message pops up saying
that the “current view has been saved”.

To see this view again, exit station view (or select More > Map) and tap the Info icon 0 in the
bottom right corner.

i

No Entity Selected

When the info button is yellow, tap the marker where you just saved the view. A menu appears next
to the information ribbon.

Tap the arrow next to Snapshot Image to view the marker name, station number, description, XYZ
coordinates, and a thumbnail image of the view you saved.
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Ly S
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Vent

A station 9

E A typical vent
for HVAC

X -4.120ft
Y 11.495ft

q Z -4.758ft N
Snapshot Image E

Q Vent

X -4.120ft
Y  11.495ft
Z -4.758ft

Snapshot Image @

5. To exit this view, tap the Info @) icon.

Floor Analysis

The floor analysis feature allows you to create a floor flatness and floor levelness report based on scan data.
It also allows you to create contour lines and a grid of points that can be used to aim the instrument at the
high and low points.
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Floor Flatness and Floor Levelness

To create a floor flatness and floor levelness report:

10.

11.

Tap the Scan icon & in the menu bar and then tap Floor Analysis towards the bottom of the menu.

Make sure the Floor Flatness/Floor Levelness icon is selected in the bottom left-hand corner.

Tap the Floor Selection tool located above the information ribbon to open the menu.
Tap the +icon to add a new floor.

Use the red, green and blue arrows to move the limit box to show only the floor of the area you
would like to analyze, being sure to adjust the Z-axis as well.

Once you have selected the region you want to analyze, tap the Confirm @ icon. The floor is
extracted with the selected points.

Tap the Save @ icon to save the extracted floor.

You can select the Edit icon at any point to change the name or assigned layer of this extracted floor.

Floor 1 6
FF: 8.90 FL: 23.36
Floor 2 6
FF: 0.00 FL: 0.00

To readjust the selected floor from the current extracted points, tap the Crop @ icon next to the
edit icon. This will delete the current saved floor.

&

<

Once you are satisfied with the extracted floor, close the floor selection tool by tapping the floor
selection icon.

The software prompts you to add sample lines to the floor. Based on the minimum number of
reading requirements that is generated based on the size and density of the point cloud, you may
have to create several lines to meet this requirement. Select the + icon to create a line. The minimum
line length is 11ft.
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To create a line, tap one point on the floor and then drag your finger across the floor a short distance
away from the first point to determine the length of line you would like to use. You can adjust this
line by tapping and dragging the endpoints or by tapping and dragging the complete line.

When you are satisfied with the length and location of the line, tap Accept.

Repeat this process until you have met the minimum number of reading requirements. You can
alternate the direction of the lines as well as overlap them. When you have met the minimum
number of readings, the Preview button appears.

10m

Il Flat

Overall Levelness: 13.24

In the preview menu, you can edit the minimum local value and specified overall value for both the
floor flatness and floor levelness. Once complete, tap the preview button to view the report. To go
back to the map, tap the Map icon.

The Floor Flatness Report is automatically generated in a browser link and presented to you once it
finishes processing.

Right-click the report to save the .html report or to print the report as a PDF to a folder of your
choosing.

Trimble FieldLink User Guide| 136



Scanning

| 2 0= = = s -
C FieldLink

Floor Flatness Report
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Contour and Point Creation

To create contour lines and points that allow the instrument to aim to:

1. Tapthe Scanicon & in the menu bar and select the Floor Analysis option near the bottom of the
menu.

2. Make sure the Floor Contours icon @& is selected in the bottom left-hand corner.

Select the Floor Selection tool located above the information ribbon to open the menu.

4, Tap the +icon to add a new floor. If you have already extracted a floor, select which one you would
like to analyze and skip to step 9.

5. Usethered, green and blue arrows to move the limit box to show only the floor of the area you
would like to analyze.

6.  Once you have selected the region you want to analyze, tap the Confirm icon @. The floor is
extracted with the selected points

7. Once the extraction is successful, tap the Save icon @ to save the extracted floor. You can select
the Edit icon at any point to change the name or assigned layer of the extracted floor.

8.  Toreadjust the selected floor from the current extracted points, select the Crop icon @ next to the
edit icon. This will delete the current saved floor.
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Once you are satisfied with the extracted floor, exit the floor selection tool by tapping on the Floor
Selection icon @) again.

The contour lines along with the high, in tolerance, and low points are automatically generated
based on the tolerance specifications you set in the edit menu. To change the resolution (distance
between points), elevation and tolerance, tap the Edit icon in the bottom center of the screen.

Resolution: 1 ft
Elevation: -5'101/8"

Tolerance: 1/4"

High

@® In Tolerance

Low

Resolution 1 ft

Elevation -12' 5 15/16"

Tolerance 1/4"

Once your tolerance settings are adjusted, tap the Edit icon again to reprocess the grid.

To change the floor elevation outside of the edit menu, use the Touch Scan PointE icon and select
the individual scan point you would like to change the elevation to.

| (0

screen.

The individual points are generated and shown on screen. Tap the Edit icon on the bottom of the
screen to edit the name, description and layer to save the points under. Once complete, select the
edit icon again to close this screen.

Trimble FieldLink User Guide| 138



Scanning

TIP - If you plan to export the generated points as a CSV file, provide a unique description or
layer to easily separate these points from other points created in the project. The points
extracted from the floor analysis are automatically added to a default layer named “Floor X"

15.  To view the Floor Report, tap the Report button [€&#] on the bottom of the screen.

C FieldLink
Floor Report

Date I
Time I
FieldLink Job

Total Points
High Points

In Tolerance Points
Low Points

High Contours
Total High Area

Total High Volume
In Tolerance Contours

16.  Once in the report preview screen, you can either return to the map view or save the report to your
desired location.

17.  Toview the generated points report as a CSV file, navigate to More > Projects > Export and filter
out the floor points you would like to export. Select CSV as the file type and the press Export.

A B C D E F G H |
1 |NAME .X( ft) Y[ ft) Z( ft) DESC LAYER ATTRIBUTIATTRIBUTEL VALUE
2 |Floor1 0 -29.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
3 |Floor11 -28.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
4 |Floor1_2 -27.19  26.811 -5.845 Not stake: 0 SurfacePoNot calculated
5 |Floor1_3 -26.19  26.811 -5.845 Not stake: 0 SurfacePoNot calculated
6 |Floor1 4 -25.19 26.811 -5.845 Not stake 0 SurfacePa Not calculated
7 |Floor1 5 -24.19 26.811 -5.845 Not stake 0 SurfacePa Not calculated
8 |Floorl 6 -23.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
9 |Floor1 7 -22.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
10 |Floor1_8 -21.19  26.811 -5.845 Not stake: 0 SurfacePoNot calculated
11 |Floor1 3 -20.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
12 |Floor1_1C  -18.1% 26.811 -5.845 Not stake 0 SurfacePa Not calculated
13 |Floor1_11 -18.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
14 |Floor1 1z -17.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
15 |Floor1 13  -16.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
16 |[Floor1_ 14  -15.19  26.811 -5.845 Not stake: 0 SurfacePoNot calculated
17 |Floor1_ 15 -14.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
18 [Floor1_1€  -13.19 26.811 -5.845 Not stake 0 SurfacePa Not calculated
19 Floor1 13 -12.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
20 [Floor1 18 -11.19 26.811 -5.845 Not stake 0 SurfacePo Not calculated
21 |Floor1_1¢ -10.19  26.811 -5.845 Not stake: 0 SurfacePoNot calculated

18.  The default save location for the reports is User > Documents > FieldLink > Reports > Floor
Reports and the default location for CSV exports is User > Documents > FieldLink > Exports.

Contour and Point Layout

Once you have collected a scan of the area around you, generated the contour lines and have set-up the
instrument on two points, you can now use the instrument to aim at the high and low points on the contour
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lines. To do this:

Ensure the instrument is set up by tapping Device and then tapping Set Up.

2. Go to the Floor Inspection contour creating menu by tapping Scan > Floor Analysis > Contour
Creation.
3. Once the contour lines have been created and the instrument is leveled and set up, select the
contour line to layout. The individual points that make up that line appear.
4.  Tap the point you would like to aim the laser pointer at.
The Aim button should appear solid. Tap the Aim button.
Inspection

The inspection feature enables you to compare the model to the collected scan to check for any
discrepancies. To complete an inspection, the 3D model must be imported into your FieldLink project and the
points must be aligned with the model.

NOTE - The most accurate way of aligning scan data with a 3D model is by creating points on the model
and performing a resection based on those created points. See Background Plan or Model Set Up
(Resection), page 112 for more.

To use the inspection feature with 3D model and scan data:

1.

vk W

Ensure the 3D model and point cloud are aligned.

Tap the Scan icon 4.
Tap Inspection.
icon on the bottom of the screen.

Tap the Edit Inspection &)

The Inspection menu appears allowing you to set the maximum tolerance and tolerance interval,
save destination for images and the inspection name.

Maximum Tolerance Name Inspection 1

Tolerance Interval 1/8" pestination C:\Users [ Documents\FieldLinkimage:(
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Once these parameters have been set, tap the Edit Inspection icon again to exit.

Tap the Inspection icon 6" on the lower right side of the screen to begin the model inspection.

Once the inspection process is complete, an array of colors appears on the 3D model showing where
the data is within tolerance based on the interval set in the Inspection Editor.

4 (O

You can produce several model inspections with different tolerances within the same project. Tap
More > Map to return to Map view and then go back into the Scan > Inspection menu and conduct
a new inspection.

To toggle between the different inspections, tap the Inspection ribbon and select the inspection you
would like to see.

Inspection 1 [111]

4
Inspection 2 m 0

You can change the tolerance by the increment you set by using the + and - buttons on either side of
the tolerance menu in the middle of the screen This affect only the color range that is selected and
changes by the increment you set in the inspection editor.

You can turn off intervals and colors by selecting a color/range in the menu and then tapping on the
eyeicon.

Tap the camera icon in the bottom right corner to save screenshots to the default images folder
under Documents > FieldLink > Images.

You can also export the colored inspection clouds in LAS, LAZ and e57 formats.
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To create an Inspection Report, and save it locally, to a thumb drive or to Trimble Connect.
1. Once the Inspection is created, tap the Next icon.

2. Tap the Preview icon.

3. Tap Save to save the report. To change the location of the report, tap the Input Form icon
a

X7/X9 Scan Registration

If the scanner has at least two scans loaded in the active project, you can manually move and register the
scans directly in FieldLink if they do not automatically register. There are two options to register scans
manually. You can rotate the scan to a different orientation to better match the orientation of the reference
scan or move it to an area where more overlap occurs with the reference scan. An alternative is to use Split
View to select two visible surface planes that are shared between the two stations.

~

Tap the Scan & icon and then tap Register.

In the dropdown menu on the bottom bar of the screen, select which station you want to move
under the Moving dropdown. A blue circle with red and green arrows (- appears around the station
icon that you are now moving.

Moving Reference

. ( &1 A REGISTER

Select which station you would like this station to register to by selecting it under the Reference
dropdown.

Using the blue circle and red and green arrows, move and rotate the scan data to match the
orientation of the scan you are referencing in both plan and elevation views.

When the scan is in the same orientation as the reference scan, tap the Register button to register
the scans together.

The two scans are now linked together. To unlink these scans and move them separately, tap the X
between the two station numbers in the bottom menu.

If the registration refinement fails, you are prompted with the red pop-up below. If this continues, try
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the Split View option.

® Registration Failed - Verify scan placement and retry (or) use splitview to register

To use Split View:

1.
2.

Tap the Split View icon m

Once Split View opens, select which station you are moving and which station you are referencing in
the dropdown menus on the bottom of the screen (moving station view is on the left side of the
screen and the reference station view is on the right side of the screen).

Tap a surface that is visible from both stations. Once you select a surface, a white circle appears. On
the other screen, select the same surface. A white dot appears.

Tap a different surface visible from both stations on both screens. These points should be blue. See
the example below:

TIP - Choosing flat, bright-colored, non-reflective surfaces produces the best results when using
Split View as these areas have more accurate scan data.
Once both points have been selected on both screens, tap Register.

Repeat these steps if the scan fails to register again. If the scans still do not register successfully, you
may want to scan the area in between these two stations to better stitch together the data.

To have the most accurate scans and registration, Trimble recommends that you refine the scans
once you have finalized the registration process.

X7/X9 Refining Scans

> won

Tap the Scan icon.

Tap the Refine button.

On the bottom of the screen, a menu appears. Tap the Refine button to begin the refining process.
Once the refining process is complete, the Report tab is available.

Tap Preview to open the report in a browser page. The report tells you how well the scans are
refined and registered by giving you the average error in millimeters, the confidence percentage, and
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the average overlap. Right-click the report and save the .html report to a folder of your choosing. You
can also right-click and print the report as a PDF to a folder of your choosing.

' NOTE - The tolerance settings for the scan refine report are adjustable.

Py ro® T

Scan Refinement Report

Job Summary

Stations Registration Group(s) Unregistered station(s)
9 1 0

Average Erfor (mm) Average Overlap (%) Average Confidence (%)

97.95

Registration Summary

X7/X9 Scan Export and Diagnostics Report

Export

Once you have finished scanning, you can export scans to view later in FieldLink Office, Trimble Realworks,
SketchUp and other supported CAD software. To export scans:

1. Tapthe Scan icon & and then tap Export.

2. Onthe bottom bar, tap the dropdown menu and select the file type to export. The options are TDX,
POD, LAS, Structured RCP, Non-Structured RCP, TZF, Structured E57 and Non-Structured E57.

3. Click the Export button.

4.  Choose where to export the file to on your device (use the up arrow to navigate between save
folders). You can also select whether to either refine or colorize the points during export. If you have
already colorized and refined the points, the checkboxes are selected and grayed out.

5.  Click the Export button again to begin the export process. Export time depends on how many scans
you have, whether the points have been colorized whether the file has been refined.

RCP- Structured
RCP- Non-structured
TZF
E57- Structured

E57- Non-structured

RCP- Non-structured
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Two Diagnostics Report

If you encounter an issue with the X7/X9 or to check the instrument health, use the built-in diagnostics report
function. To create a diagnostics report:

1.
2.
3.

4.

Ensure the software is connected to the Trimble X7/X9 laser scanner.
Tap on Device > Settings > Diagnostic.

Once you tap the Diagnostic button, the Trimble X7/X9 begins spinning and the yellow lights flash.
Make sure to not touch or move the X7/X9 while it is moving.

On-board Diagnostic Report
Tuesday, September 1, 2020
X7 Autotest - INFO ilename X7_89802108_autotest_result_000
9/1/2020 4:02:55 PM
X7 -INFO irmware R2.1.3
rial 89802108
X7
\WiFi - OK WiFi Channel AUTO

Once you have viewed the report, tap the Preview button to open up a browser page. Right-click the
report and save the .html report to a folder of your choosing. You can also right-click and print the
report as a PDF to a folder of your choosing.

Calibration Report

To access the X7/X9 instruments Calibration Report:

1.
2.
3.

Ensure the software is connected to the Trimble X7/X9.
Tap Device and then tap Settings.

Tap Calibrate Instrument.
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Overall Result Success

X7 Fieldcalibration Report | INFO  Date Time

Firmware
X7 | INFO Serial
Model

Condition | PASS Inclination
Vibration
Ambient light

Runtime
Temperature

Horizontal Accuracy

10/5/2020 2:32:55 PM

R2.1.4
89802108
x7

16 min
23°C
16°
Low
PASS

PASS

Scanning

You have the option to open the report in a browser page. Right-click the report and save the .html
report to a folder of your choosing. You can also right-click and print the report as a PDF to a folder

of your choosing.

Log Files

If FieldLink encounters an error or crash, Trimble Support may ask for the log files in order to better

understand what caused the issue. To access these log files:

Through FieldLink

1.

2.

3.

Tap More and then tap About.

Tablet Seris| Number: DELL HaBSsY2
Support Expirtion: /1772020

The About menu appears. Tap Log Files in the bottom right hand corner. The file explorer opens,

revealing the save location of the FieldLink log files.

Select the Sessions folder and find the most recently saved file from your project.

Name
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Through File Explorer

1. Open the File Explorer.

2. Make sure that Hidden Items is checked under the view ribbon. You will need to see the AppData
folder.

3.  The save location for log files is Users > Username > AppData > Local > FieldLink > LogFiles >
Sessions.
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GNSS Module

You can use GNSS when connected to a Trimble GNSS receiver. For a list of supported receivers, see
Supported Hardware, Firmware and Operating System.

GNSS Coordinate Systems

If you have purchased FieldLink Advanced and the GNSS module you can select the coordinate system and
zone for your projects to ensure that collected and staked data is in the correct reference coordinate system.

You can select the coordinate system and zone when you create the project.

Geoid  GEOID18 (Conus)

( AccerT |

If required, you can change the coordinate system and zone once a project is created by going to More >
Projects > Manage and selecting the pencil icon next to the project name.

GNSS Setup

This section covers setting up the GNSS receiver before you start. Depending on your requirements, you can
set up the receiver using one of the following methods:

e Unknown Location - Base & Rover, page 149
¢ Known Location - Base & Rover, page 150

e« No Datain the Job, page 151

¢ Retain Station Setup, page 152
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GNSS Module

Unknown Location - Base & Rover

The Base Station can be placed in a convenient location as long as there are at least three control points with
a known location in the field of view. It is important to place control points with good geometry balance
around the job site.

,.
# \;
\
| ‘ (
\ il '
g

'f& ,'
r H
| \ W
|

WARNING - Performing this setup creates a calibration file. If a calibration file existed from a previous

setup, the new setup rewrites the old calibration files.

1. Select a point from the map, set the rover with pole at that location on the job site, and select
measure. Repeat step 1 for all three control points.

2. After you measure all 3 points the horizontal and vertical residuals populate in the bottom taskbar
and you can tap the Set button. To create a point where the base is located, tap Store Base

Location.
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W/ Setup successful

Known Location - Base & Rover

GNSS Module

On the jobsite, it may be convenient to setup the base station on a known point to conduct your layout. It is
recommended to verify the quality of the set up by shooting another known reference point before layout.

Use the following procedure to complete the known point setup.

1.  Tap base point location on map.

2. Tap Set Over Point.

Set Base anywhere on job site or select Base location on map

SET OVER POINT

3. Once Base Station in established, tap Find Rover.

+/ Base position established !

ROVER

4.  Tap Rover and wait to see the Rover connection successful.
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? SPS986 6015F00141 Trimble

Devices Found

/N SPS986 6015F00151 Trimble

&/ Rover connection successful

5. Once the Rover is connected and receives corrections, GPS precision will be in tolerance.

&/ GPS precision in tolerance

vog . H.Predsion: 1/4

( 56 3/4= ) V. Precision: 172
\_H /

/

~——" Tilt Ready

No Data in the Job

Can be performed in a job with no imported points or model data.
1. Tap Moreﬂ and then tap Projects.
2. Tap Manage and then tap Create.

3. Name the job and then tap Create.

|NewJob Name\No Data Set Up|

Location C:\Users\Trimble Loaner\Documents\FieldLink\Jobs

|

c

0/0/0/6/00/0/0/00]0/0/0]0Y -

0l0/0/GI0I0/C/CIONO/0/0I0P
ool 100010
© 0 0

SAVE AS OPEN DELETE

4, Tap Devicﬂ and then tap Set Up.

@ Steady the receiver and measure to perfom a No Data Setup ®

5. Steady the receiver and select Measure to complete setup. To create a point where the base is
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located, tap Store Base Location.

V/ setup successful

GNSS Set Up - VRS/RTK

VRS is a correction service for GNSS workflows. VRS gives access to RTK correction services using a network of
permanent, continuously operating reference stations. (Strong LTE connection required for reliable VRS use).

Once you are licensed with a VRS Subscription, enter your subscription credentials in FieldLink under the
Device Settings VRS Menu. Once the credentials are received the closest mountpoint to use for the
correction service is selected in the drop down list.

To determine the proper mount point to use, please refer to your project manager for this information.

GNSS Set Up - RTX

RTX is a correction service for GNSS workflows. RTX only requires satellite signals for positioning, making it
the easier, more accessible GNSS workflow.

Once the GNSS receiver is licensed with an RTX license, a coordinate system MUST be assigned to the project
for you to be able to use the RTX correction option.

' NOTE - RTX option is available for a local setup or by selecting a Coordinate System for the Project.

When you open a project that has RTX set as the correction method, you must wait until satellite
convergence. Once convergence is reached (the receiver has obtained its location within accuracy
parameters) you can continue.

Retain Station Setup

If you have performed a station setup (total Station, GNSS or scanner setup), you can retain that setup and
the control points used for the setup when changing jobs within one project. This means you can navigate
efficiently between layout jobs in one project without having to re-setup the instrument.
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Tilt Calibration

Once you have set up the base station and rover, initialized VRS or RTX, it is possible to enable the tilt
compensation feature. Complete the plumb pole routine to calibrate the rover pole. After calibration, it is
possible to layout or collect without leveling the rover pole.

NOTE -
e The use of the quick release is not recommended when using Tilt Compensation.
e Tilt compensation will not work with a pole less than 1.5 meters in height.

1. Tapthe Prismicon.

2. Check the Enable Tilt Compensator box.
3. Click the Plumb Pole button.
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Geoid  GEOID18 (Conus)

Set the tip at fixed location.

Rotate the pole to the designated pie piece and keep it in the green during the first part of the
calibration procedure.

Tap Start.

Heading: 359.90°
Pitch: 5.01°
Roll: -0.21°

e
[E] position tip over fixed location ( smarr ) (X
N AN

)

Heading: 44.76°
Pitch: -0.93°
Roll: -1.01°

[E] Position tip over fixed location

' WARNING - Do not move the tip of the pole until the calibration procedure is complete.

Once the first part is complete the toast will tell you to rotate the pole 180 degrees (do not move the
tip) and tap Continue.

Repeat the same step as before.
The apply corrections toast appears and tap Yes.

Plumb Pole corrections successfully applied toast appears and you're done.

' NOTE - If you switch poles this step will need to be repeated.
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Heading: 45.51°
Pitch: -0.42°
Roll: -1.12°

Tilt: 1.19°

E Keep tip of pole over fixed location and rotate pole 180° ( conTinud ( cANCEL

Heading: 225.74°
Pitch: 0.37°

Roll: 0.13°

Tilt: 0.39°

GNSS Layout

Once you have connected to the base station and rover and set up on the project, initialized VRS, or initialized
RTX, you can now collect and lay out points, lines, and arcs.

1. Tap Measure i and then tap Layout.
2. Tap the point to lay out.

3. The grey arrow g shows the direction you need to go. The smaller blue bullseye with arrow Vd
(available with tilt compensation) shows the direction you are pointed.

NOTE -

e With the tilt compensator you have both indicators. If you don’t have the tilt
compensator enabled only the grey arrow is shown.

e To change between fast GNSS measurements and high precision GNSS measurements,
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' go to Layout > Settings.

® =

GNSS Out of Precision Point Collection and Stakeout

While using the Layout, Layout Plane, or Collect features with a connected GNSS receiver, this icon @ will
appear when the receiver is operating outside acceptable precision.

If you attempt to stake or collect a point while the receiver is out of precision and the icon above is showing in
place of the receiver location, a confirmation toast will appear prompting you to confirm whether you still
want to store that point.

] control

The following point and layout types are compatible with GNSS Out of Precision, and the icons below
indicate how each point was collected or staked within FieldLink:

e o Collected Point out of Precision

e« '@ Collected Control Point out of Precision

e '® Staked Point IN Tolerance and out of Precision
e '@ Staked Point OUT of Tolerance and Precision

e '@ Staked Plane Point IN Tolerance and out of Precision
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¥ Staked Plane Point HIGH (Out of Tolerance and Precision)

‘a Staked Plane Point LOW (Out of Tolerance and Precision)

GNSS Module
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Legal information

Legal information

Trimble Inc.

trimble.com

Copyright and trademarks
© 2025, Trimble Inc. All rights reserved.
Trimble and the Globe and Triangle logo are trademarks of Trimble Inc., registered in the United States and in other countries.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or
other countries. All other trademarks are the property of their respective owners.
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